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Trademarks
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Instruction Symbols

The following icons appear in the document:

@ Note: Important additional information.

% Example: Practical illustration of a process or procedure.

Q Tip: Suggestion or hint to guide or assist users performing a task.

Warning: Warning against potential mistakes and actions that could cause critical error.
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Introduction

Congratulations on choosing BackupVault Server Edition. BackupVault minimises risk, maximises productivity

and allows businesses to regain control of their most valuable asset - their data.

For technical support, please go to Help > About BackupVault SE, and then use the contact details provided.

Product overview

With BackupVault Server Edition (SE), data stored on servers and databases can be backed up to a Storage

Platform quickly, securely and automatically.

Storage Platform

SE

SE

g
-
-~
-
-
-
-
-

LA MMM

The following diagram illustrates the scenario:

Files and folders stored on one or more servers running
SE can be backed up to a Storage Platform. In the event
of data loss or corruption on the server, you can retrieve
data from the Storage Platform and restore it to the
original or another server in just a few easy steps.

A Backup Administrator can manage the entire backup
environment (Backup Clients and the Storage Platform)
remotely, using the BackupVault Storage Platform
Console. For more information, please refer to the
Storage Platform Console User Manual.
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1. Getting started

Enabling manual or automatic backups is easy with BackupVault Server Edition:

2. Create a Backup 3. Select files and folders 4. Backup - Automatically

1. Install SE Account for backup or manually

2. Installation

For the latest system requirements and compatibility information, please refer to the System Requirements and
Compatibility Matrix.
The SE MSI file contains pre-configured information to make installing SE quick and easy. For more information

on creating MSI files and launching them from the Run Command, please refer to the Storage Platform Console
User Manual.

Note: The options available during the installation process depend on the settings enabled by the
@ administrator when the MSI file was created. These options range from advanced install settings to
specifying the install location. The default install path is: C:\Program Files\BackupVault.

Warning:

e Ifrunning antivirus software, please ensure that all BackupVault folders are excluded from
antivirus scans to avoid data corruption.

e Both antivirus software scans and backup processes are resource-intensive. It is advised
not to run a backup and virus scan at the same time as this will significantly decrease
machine performance.

o Windows will check whether you are running the MSI file suited to the installed operating
system (i.e. 32-bit or 64-bit) and will not allow you to install the wrong version.

To install BackupVault SE:
1. Run the MSI file.

2. In the BackupVault SE Setup Wizard that appears, follow the steps as described below.

BackupVault SE Setup Wizard

The BackupVault SE Setup Wizard typically consists of five steps to guide you through the Setup task in a
simple, step-by-step manner.

Note:

e Some of the settings described below may have been removed when the MSI was created.
Furthermore, the wizard may contain additional steps. Please read each window carefully
before continuing.

7
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e Ifyou receive a Windows User Account Control message, asking you if you wish to allow the
BackupVault program to make changes to the computer, click Yes to proceed.

Step 1 of 5: Start the BackupVault SE Setup Wizard

To start the BackupVault SE Setup Wizard:
1) BackupVault SE Setup ] ® |

Welcome to the BackupVault SE Setup
Wizard

The Setup Wizard will install BackupVault SE on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.

8
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Back \[ Next ] [ Cancel ]

Click Next.

Step 2 of 5: Specify a Windows user account

To enable the Backup Client to read all files that must be backed up, it may be necessary for the Backup Client
service to run under a specific Windows account.

To specify which Windows account should run the backup service:

5! BackupVault SE Setup o B ‘E
Service User Account [ @
Normally the backup service runs under the LocalSystem account, but that f -
can be changed here.

@ Run as LocalSystem

(©) Run under this user account:

User Name:

I e.g. Domain\User

Password:

Validate

[ Bak J[ Net ] [ cancel |

e Select Run as LocalSystem.

e Alternatively, specify a specific Windows user account:

8
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1. Select Run under this user account.
In the User Name box, type the Windows user name for the account.
In the Password box, type the Windows user account password.

Click the Validate button.

o &~ N

Once the Windows user account has been validated, click Next.

Warning: Please ensure that the user account specified in this step has full access to all files to be
backed up. If files are included for backup that the account does not have access to, a “Some files
were skipped” or “files skipped” error message will display in the backup logs.

Step 3 of 5: Specify an install location

To specify a destination for the SE application files and folders:

ﬁ BackupVault SE Setup o B @‘

Destination Folder @
Click Next to install to the default folder or dick Change to choose another. | |

Install BackupVault SE to:

IC:\Program Files\BackupVault\Backup Client SE\

[ Back ][ Next ] [ Cancel ]

e Click Next to accept the default destination folder and continue to the next wizard step.
e Alternatively, specify a new destination folder:

1. Click the Change button.

2. Browse to the folder.
3. Click OK.
4

Click Next to continue to the next wizard step.

Step 4 of 5: Begin the installation

Once all the settings are configured, the wizard is ready to begin the installation.

To begin the SE installation:

9
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‘ﬁ‘ BackupVault SE Setup lE”ﬂ'

Ready to install BackupVault SE r(m ! @
-

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back || Gmstal | [ Cncel

Click Install.

Step 5 of 5: Exit the BackupVault SE Setup Wizard

The last step of the wizard presents the option to launch the Backup Client.

To launch the Backup Client immediately after the BackupVault SE Setup Wizard:
1. Ensure that the Launch BackupVault SE check box is selected.

Lol @ (s

1) BackupVault SE Setup

Completed the BackupVault SE Setup
Wizard

Click the Finish button to exit the Setup Wizard.

8

BACKUPVAULT [¥] Launch BackupVault SE
Back Finish Cancel
2. Click Finish.
Note:

o Ifthe MSI file is being run from the same location as the plug-in installer file, the Setup
Wizard will give you the option to launch the plug-in installer before launching the Client.
Select the Launch Plug-in Installer check box to run it immediately after the BackupVault
SE Setup Wizard. For more information about plug-ins, please refer to the Server Edition
Plug-ins User Manual.

10
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e Before the Plug-in Installer launches, a User Account Control dialog box may appear,
asking you if you wish to allow the Plug-in Installer to make changes to the computer. Click
Yes to run the installer.
If you selected the Launch BackupVault SE check box in the last step of the BackupVault SE Setup Wizard, the
Backup Client will open automatically upon clicking Finish and the Setup Wizard (which is the Backup Account
Wizard and Backup Wizard combined) will launch, enabling you to create a Backup Account and configure your
backup settings. Follow the wizard steps as described in Chapter 3, “Setup Wizard”.

If you opted not to launch the Backup Client immediately, you can open the Backup Client interface at a later
stage via the Start menu or by following any of the instructions listed under Opening the Backup Client in
Chapter 5, “Graphical User Interface”.

@ Note: The Setup Wizard will launch when you open the Backup Client for the first time.

11
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3. Setup Wizard

The Setup Wizard consists of the Account Wizard and Backup Wizard combined into one. It is used to set up a
Backup Account (which is required for backing up) and configure your backup settings. The Setup Wizard runs
automatically the first time the Backup Client is opened. You can run the standalone Account Wizard or Backup

Wizard at any other time by clicking:

e Tools > Wizards > Account Wizard

e Tools > Wizards > Backup Wizard

Note: If you run the Account Wizard, a warning box will appear. Click the Run Account Wizard
button and follow the instructions.

If you selected the Launch Backup Client SE check box in the last step of the BackupVault SE Setup Wizard
(see The BackupVault SE Setup Wizard in Chapter 2, “Installation”), the Backup Client will run and display the
Setup Wizard automatically.

If the Launch Backup Client SE check box was not selected in the last step of the BackupVault SE Setup
Wizard, the Setup Wizard will launch when the Backup Client is opened for the first time (for more information,
see Opening the Backup Client in Chapter 5, “Graphical User Interface”).

The Setup Wizard typically consists of seven steps to guide you through the setup task in a simple, step-by-step
manner.

Note: Some of the settings encountered in the wizard may have been removed when the MSI was
created. Furthermore, the wizard may contain additional steps. Please read each window carefully
before continuing.

Step 1 of 7: Specify Storage Platform settings

To specify the Storage Platform settings:

1. In the Storage Platform address box, type the IP address or DNS name of the Storage Platform where
the Backup Account resides.

Storage Platform settings

Enter the Storage Platform settings:

Storage Platform address: [2550D

Backup Group: |Taahir

Backup Group Create Key: |""""""‘"

Please contact your backup administrator if you don't have the required information.

12
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2. In the Backup Group box, specify which Backup Group the Backup Account belongs to.

Note: Type the Group name in relation to any Collections it may belong to, for example:
COLLECTIONA\COLLECTIONB\GROUP

3. In the Account Create Key field, specify the preconfigured Backup Account create key for the
applicable Group. If you do not have access to this key, please contact your Storage Platform
administrator.

Note: This key is case sensitive.

4. Once all the correct settings have been entered, click Next.

Step 2 of 7: Create or connect to a Backup Account

You can either create a Backup Account or connect to an existing Backup Account.

To create a new Backup Account:

1. Select | want to create a new Backup Account.

Backup Account Type

Specify the Backup Account type:

¢+ Iwant to create a new Backup Account

¢~ Iwant to connect to an existing Backup Account

2. Click Next.

To connect to an existing Backup Account:

Note: You can select I want to connect to an existing Backup Account to:

e Connect to an Account that has been opened for use by this computer.

e Reconnect to an Account to recover data from the computer that had previously backed up
to this Account.

1. Select | want to connect to an existing Backup Account.

Warning: Different servers cannot back up to the same Backup Account. A separate Backup
Account needs to be created for each server.

2. Click Next to continue.

13
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Step 3 of 7: Specify Backup Account details

Depending on the option you selected in the previous step, you will either be prompted to specify new Backup
Account details or to supply the already configured details of the existing Backup Account.

To specify new Account details:

1. In the Backup Account name box, type a Backup Account name that consists of a minimum of 4
characters.

1
OO0

Enter your preferred Backup Account details:

Backup Account name: ITAAHIR-PC

Backup Account password: Ixxxxxxxx

Minimum 4 characters

Confirm password: Ix xxxxxxx

Encrypt your data on the Storage Platform:

Encryption key: Ixxxxxxxx
Minimum 8 characters

Confirm key: |

If you lose this key you will not be able to restore your data. Please write it down and store
it somewhere safe.

Set up connection settings...

2. In the Backup Account password box, type a password that consists of a minimum of 4 characters.
Confirm it in the Confirm password box.

3. Inthe Encryption key box, type an encryption key that consists of a minimum of 8 characters. Confirm it
in the Confirm key box.

Warning: Please write down your encryption key and store it in a safe place as YOU WILL
NOT BE ABLE TO RESTORE YOUR DATA WITHOUT IT.

4. Click Set up connection settings... if you'd like to configure your connection to the Storage Platform.

5. Click Next.

When connecting to an existing Account:

14
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|
OO0

Enter your existing Backup Account details:

Backup Account name: I

Backup Account password: I

Minimum 4 characters

Encrypt your data on the Storage Platform:

Encryption key: I

Minimum 8 characters

1. In the Backup Account name box, type the Backup Account name.

o M 0N

Click Next.

Set up connection settings...

In the Backup Account password box, type the Account password.
In the Encryption key box, type the encryption key chosen when the Backup Account was created.

Click Set up connection settings... if you'd like to configure your connection to the Storage Platform.

Step 4 of 7: Confirm Backup Account summary

Confirm that the information you have supplied is correct, and then click Create or Reconnect, depending on

whether you are creating a new Backup Account or connecting to an existing Backup Account.
- |

The Backup Client will connect to the
Storage Platform and configure your
Backup Account. A message will be
displayed confirming that your Backup
Account has been successfully configured.

This is the last step of the Account Wizard.
After your Backup Account is successfully
configured, the Setup Wizard will
immediately start the Backup Wizard to
help you configure your backup settings.

Step 5 of 7: Schedule backup
process

Backup Account Summary

Storage Platform settings

Storage Platform address:  2650D
Backup Group: Taahir

Backup Account settings

Backup Account name: Taahir-PC
Backup Account password: FFFFEEE=

Encryption

Encryption kEY: EEEEEEEE

15
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BackupVault can run backups on included
files and folders either upon request
(manually) or automatically. This step
enables you to set up a backup schedule.

Tip: It is advised to back up at
night when the server is running
and the Backup Client is not in
use. The server must be
switched on at the time(s)
specified for scheduled backups,
but the Windows user does not
need to be logged in.

To configure the Backup Client to run
only manual backups:

Warning: This option is not
recommended. If an automated
backup schedule is not created,
backups will have to be run
manually. Enabling automatic
backups is strongly advised.
1. Clear the Daily automated backup
and Advanced schedule... check
boxes.

2. Click Next to move to the next step
in the wizard.

To schedule a daily automated backup:

Backup Schedule

Set up your automatic backup schedule:
¥ Daily automated backup @ [ 1900 |

™ Advanced schedule (back up at the following times):
Week day

Advanced schedule

Backup time:
e 12hoo | =

Add

Delete I

Help Back | Next I Cancel

1. Select the Daily automated backup check box.

2. Specify a time in the associated box.

3. Click Next to move to the next step in the wizard or create an advanced backup schedule as described

below.

To create an advanced backup schedule:

1. Select the Advanced schedule (back up at the following times) check box.

In the Week day box, select a day on which a backup should be initiated.

Specify the time in the Backup time box.

Repeat the steps above until you have added all desired schedules.

2
3
4. Click the Add button to add the day and time to the Advanced schedule box.
5
6

Click Next to move to the next step in the wizard.
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Step 6 of 7: Optimise for backup environment

The Backup Wizard enables you to quickly optimise your settings for backing up in a specific environment.

To optimise your settings:
1. Select what type of connection you use to back up.
2. Select whether you want to optimise to minimise time and disk usage or transfer size.

Using the options you have chosen, the Backup Wizard displays a compression and processing
summary that details the effects your choices will have. It also provides a brief summary of these effects.

3. Click Next to continue.

Step 7 of 7: Confirm backup configuration

The wizard displays a summary of the choices you have made. It also shows the working folders which you can
edit by clicking the edit... link.

Note:

e If the drive on which the Backup Client is installed has limited space available, you can
move the folders and selection database to another location.

e The Temp and Cache folders must reside on the same drive/volume.

The wizard also displays a list of installed plug-ins. Certain plug-ins, identified by blue text, can be customised
from this step clicking on the plug-in. Alternatively, you can access and configure the plug-ins later from the
Tools menu.

Finally, the wizard also displays the optimisation options that you chose, together with the effects of your
choices.

Click Finish to complete the wizard.

Congratulations
You have now successfully completed the | |

back up.

Congratulations on completing this setup wizard successfully.

You may now proceed to select files and folders for backup.
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4. Updating Backup Clients and plug-ins

Backup Clients and their plug-ins are usually set up to be updated automatically but the process can be carried
out manually. You'll find a description of Auto Updates and a set of instructions on how to perform manual
updates in the following sections.

Auto Updates

BackupVault allows you to automate the update process so that the Server Edition Backup Client is updated with
the latest software version during the backup process.

Warning: If a plug-in has been deprecated, the Backup Client will only be updated to the latest
version in which the plug-in was still supported.

Update packs are created and distributed to the AccountServer. The AccountServer then distributes these packs
to the different Backup Clients as they are requested during the backup process.

Note:
@ e Auto Updates must be enabled on the Storage Platform for this feature to work. For more
information on enabling Auto Updates, please refer to the Storage Platform Console User
Manual.

e By default, if there is less than 500 MB free space available, an update pack is not
requested. This is logged to the Backup Service log.

e Backup Clients are always updated to the latest version and service pack available on the
Storage Platform.
If a Backup Client update is available, the following will occur. After the backup process has completed, if the
Backup Client GUI is open, you will be presented with an update dialog box. You have the option to update now
or cancel:

e Clicking Update now closes the Backup Client GUI and installs the update.

e Clicking Cancel closes the dialog box and does not install the update. The dialog box will appear again
the next time you back up.

If the Backup Client GUI is closed when an automated backup occurs, the update will be installed automatically.
After an Auto Update occurs, the BackupVault system tray icon will display a notification indicating that the
update was successfully applied.

Plug-ins can also be updated automatically. During the backup process, the Storage Platform will compare the
plug-in versions received from the Backup Client with the latest versions available on the Storage Platform. If
newer versions are available, the Backup Client will download the files and automatically update the installed
plug-ins.
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Manual updates

To manually update SE Backup Clients and their plug-ins:

1. Close the Backup Client application interface and the SE system tray icon.

2. Run the SE Installer.

Note: The SE Installer retrieves the install location from the backup service and cannot be
changed as you are upgrading an existing SE Client.

3. On the Welcome screen, click Next:

1) BackupVault SE Setup fol @ ==

Welcome to the BackupVault SE Setup
Wizard

The Setup Wizard will install BackupVault SE on your
computer. Click Next to continue or Cancel to exit the Setup
Wizard.

8

BACKUPVAULT

Back |[ nNext | [ cancel |

4. On the Ready to install BackupVault SE screen that appears, click Install.

5. If the BackupVault SE service is running, a Files in Use wizard screen will appear. Click OK to have
the installer stop the service, update the software and then restart the service.

If the SE service is not running when the update is being performed, the installer will update the
software and start the service thereafter.

6. On the Completion screen that displays, Launch BackupVault SE is selected by default. Clear the
check box if you do not wish to do so.
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1) BackupVault SE Setup

Wizard

8

BACKUPVAULT

Launch BackupVault SE

Completed the BackupVault SE Setup

Click the Finish button to exit the Setup Wizard.

If you have the plug-in installer file in the same directory as the new Backup Client installer file, a
Launch Plug-in Installer check box will display above the Launch BackupVault SE check box on the
Completion screen. If you wish to add or update any plug-ins at this point, ensure that the check box

is selected.

Note: If the plug-in install file is not in the same location as the Backup Client install file. You
can manually update installed plug-ins by running the plug-in installer at a later stage.
Existing plug-ins are marked with a blue icon and will automatically be updated when you
click Next. The plug-ins can also be updated automatically during the next backup process.

After the Backup Client and plug-in updates (if applicable), click Finish.

Confirm that you can open the SE Backup Client and initiate a backup to the Storage Platform.

n Backup

Invalid synch token found - ensure this is the only backup dient backing up to
this Backup Account

Backup Account authenticated

Sending backup index

Waiting for server

Backup successfully processed on Storage Platform

Updating local cache

Cleaning up cache

Cle: porary files

Ne .4KB (comp: 0.5KB)
Removed files: 0

Patched files: 0

Skipped files: 0

Cache using 0 bytes

Transmitted: 0.6 KB in 5s at 0.1KB/s
==========Backup Summary ==========
Total selection: 464 bytes in 2 files and 2 folders
Total backup time: 5s

Backup Status: Successful

~
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5. Graphical User Interface (GUI)

You can use the Graphical User Interface (GUI) to:
e Select files for backup
e Launch backups
e Schedule automatic backups
e Find files in previous backups

e Restore files and folders from previous backups

Opening the Backup Client

To open the SE Client interface (pre-Windows 2012):
On the Start menu, point to All Programs, point to BackupVault, and then click Backup Client SE.

To open the SE Client interface (from Windows 2012):
On the Start menu, click BackupVault SE.

. BackupVault
4 Baclkup\ault ESE
& BackupVault SE 7]

i D L 1L L
OOUCROP VOOt

. Storage Platform
. Bullzip
. Games

1 Back

nd files pe l

2 CDEN::

Alternatively, if the Client interface is closed but the service is still running (the “BackupVault SE” icon is visible in
the system tray), double-click the BackupVault SE icon or right-click it, and then click Open.

wy
m

arcn programs (

Note: The first time you open the Backup Client, the Setup Wizard launches automatically. For more
information on creating a Backup Account, see Chapter 3, “Setup Wizard”.
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The GUI explained

You can manage and monitor backups using the Backup Client application window, the system tray icon or the
notification bubbles that appear when certain processes occur. Below are descriptions of each of these items

and the options they provide.

The Backup Client application window contains the following areas:

n

& BackupVault SE V17.3.20 (o] ===
File Selection Tools Help
|
t 2| 4 o’ @ v
= H | = S ¢ & BACKUPVAULT
Backup Size Restore Find Options  Automate Help
: , <+
B Backup Selection L. F_lestorel B LOQS‘
8 My Computer ] Filename / Size Date ] File type
El"i'—_d |~ $Recyde.Bin 2015-07-28 10:47:18 Folder
(|~ SRecydle.Bin |~ Perflogs 2009-07-14 04:20:08  Folder
(|~ Perflogs | Program Files 2017-06-08 20:48:58  Folder
(|~ Program Files |~ Program Files (x36) 2017-03-29 21:32:52  Folder
(|~ Program Files (x86) |~ ProgramData 2017-06-13 20:45:08  Folder
(|~ ProgramData |~ Recovery 2015-07-28 10:47:07  Folder
(|~ Recovery |~ SageBackups 2016-10-12 20:34:04  Folder
| SageBackups |~ speedvault 2015-09-15 10:24:41  Folder
[}~ speedvault |~ System Volume Information 2017-06-13 22:03:01  Folder
(L~ System Volume Information |~ Users 2015-07-28 10:47:11  Folder
G- Users |~ Windows 2015-08-13 09:31:43  Folder
B~ Windows O END 1KB  2015-10-29 20:46:42  File
) pagefile.sys 2,096,696 KB 1970-01-01 01:00:00 System file
€ sghmmail.ECF 1KB  2015-07-28 16:50:48  ECFFile
Ready < !

Menu bar and toolbar buttons

All Backup Client functions can be performed from the menu bar. Shortcuts to the most commonly used menu
bar functions are also available on the toolbar and right-click menus.

Menu bar

Menu bar

Toolbar

Tabs

Status bar

Each menu on the menu bar contains one or more options. The tables below describe the options available.
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File menu
Option Click the option to... Button
Backup Initiate a backup immediately. —_—
Backup
Switch to the Restore view in the Backup Client.
v
Restore -
Q Tip: For faster access to the Restore view, click the Restore
= Restore tab instead of using the File menu.
Calculat Determine the total size of the data included in the backup selection. o
S'a culate For more information, see Determining the backup selection size in =S
ze Chapter 6, “Backups”. Size
Find Files i Access the Find Files in Backups dialog box. This box enables you to
Bm K l'es N search for particular files in your backups. For more information, see »
ackups Finding files in backups in Chapter 7, “Restores”. Eind
Selection Tools Help
Backup Mow
Restore
Export Export a list of all backup inclusions and exclusions to an html file for Calculate Size
x:oo . future reference. For more information, see Exporting a selection report o
Selection in Chapter 6, “Backups”. Find Files in Backups
Export Selection
Exit
Close the Backup Client application window.
Exit

any time via the Windows Start menu or by double-

Q Tip: You can re-open the Backup Client window at
clicking the icon in the system tray.
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Selection menu

Tools Help

Filters » Mew Filter ...

Include Folder Edit Filters ...
Exclude Folder O  Graphics N
Deselect Folder ) MS Access databases »
Refresh ) MS Office documents »
FITes F3 ) MS Outlook email »
) \Web pages »

Option Click the option to...

Filters > New Create a new filter to automate inclusions or exclusions based on file type. For more information, see
Filter Using filters in Chapter 6, “Backups”.

Filters > Edit

Filters Edit existing filters. For more information, see Using filters in Chapter 6, “Backups”.

Tools Help

Filters » Mew Filter ...
Include Folder Edit Filters ...
Exclude Folder O  Graphics 5 Tnclude
Deselect Folder
) MS Access databases » Exclude
Refresh ) MS Office documents » S
Bires Elle MS Outlook email > o
' Web pages >
Option Click the option to...

Filters > [filter] > Include Include all files in the selected folder that match the filter’s criteria. For more information,
see Using filters in Chapter 6, “Backups”.

Filters > [filter] > Exclude _Exclude_all files in the sglecte_d folder that rpatch the”fllters criteria. For more
information, see Using filters in Chapter 6, “Backups”.

Clear the selected folder of any filters currently applied to it. For more information, see

AN Rl =2 e s Using filters in Chapter 6, “Backups”.

Include Folder Include the selected folder for backup.

Exclude Folder Exclude the selected folder from the backup selection.
Deselect Folder Clear the selected folder of any inclusions or exclusions.
Refresh Refresh the selection being displayed.
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Tools menu

Option

Add Network
Volume

Additional
Backup Sets >
Add

Additional
Backup Sets >
Manage

Automatic
Backups

Click the option to...

Add a network volume. For more information, see Add
network volume in Chapter 9, “Options and settings”.

Create additional backup sets. This enables you to have
separate backup selections that you can recover as
separate sets of files. For more information, see Multiple
backup sets in Chapter 9, “Options and settings”.

Access the Backup Schedule page in the Options and
Settings dialog box. Using the settings in this dialog box,
you can manage the schedule(s) of your backup sets. For
more information, see Multiple backup sets in Chapter 9,
“Options and settings”.

Access the Backup Schedule settings in the Options and
Settings dialog box. Configure the settings in the
Automatic Backups area to set up one or more automatic
backups. For more information, see Scheduling automatic
backups in Chapter 6, “Backups”.

Add Network Volume
Additional Backup Sets  »
Automatic Backups

Wizards >

Remote Management

Health Check

Snapshot »
Plug-ins »
Options

Add Network Volume
Additional Backup Sets »
Automatic Backups
Wizards »

Remote Management

Health Check

Snapshot »
Plug-ins »
Options

Add Network Volume

Additional Backup Sets  »
Automatic Backups

Wizards »

Remote Management

Health Check

Snapshot »
Plug-ins »
Options

Add Network Volume

Additional Backup Sets  »
Automatic Backups

Wizards »

Remote Management

Health Check

Snapshot »
Plug-ins »
Options

Add

Manage

Add

Manage
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Option

Wizards >
Account Wizard

Wizards >
Backup Wizard

Remote
Management

Health Check

Snapshot >
Export Backup
Snapshot

Click the option to...
Help

Add Network Volume

Additional Backup Sets  »

Automatic Backups
Launch the Account Wizard, which is a standalone wizard Wizards »  Account Wizard
that enables you to change your Backup Account settings. Backup Wizard

For more information, see Chapter 3, “Setup Wizard”. e e
Health Check

Snapshot »
Plug-ins »

Options

Launch the Backup Wizard, which is a standalone wizard that enables you to configure your backup
settings. For more information, see Chapter 3, “Setup Wizard”.

Help
Add Network Volume
Additional Backup Sets  »
Access the Remote Management Settings dialog box. Automatic Backups
Using the settings available, you can enable Remote Wizards >

Management of the Client via the SP Console. For more
information, see Remote Management in Chapter 9,
“Options and settings”.

Remote Management
Health Check

Snapshot »
Plug-ins »

Options

Add Network Volume
Additional Backup Sets  »
Automatic Backups

Access the Health Check dialog box. Performing a Health
Check enables you to highlight possible issues. For more
information, see Health Check in Chapter 9, “Options and Remote Management
settings”. Health Check

Snapshot »

Wizards »

Plug-ins »

Options

Add Network Volume
Additional Backup Sets  »

Access the Export Backup Snapshot dialog box, which R —

enables you to configure the next backup to be a Snapshot iards ’

backup to a specific location. For more information, see Remote Management

Backup Snapshots in Chapter 9, “Options and settings”. Health Check
Snapshot > Export Backup Snapshot
Plug-ins ] Import Restore Snapshot
Options
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Option

Snapshot >
Import Restore
Snapshot

Plug-ins > Email
Notification

Options

Help menu

Option

Icon Legend

Product Help

About
BackupVault SE

Click the option to...

Access the Import Backup Snapshot dialog box, which
enables you to configure Restore Snapshot settings. For
more information, see Restore Snapshots in Chapter 9,

“Options and settings”.

Add Network Volume

Additional Backup Sets »

Automatic Backups

Wizards

Health Check
Snapshot
Plug-ins

Options

Access the Email Notification settings dialog box, which

you can use to enable/disable Email notification and

configure its settings. For more information, see Email

Notification plug-in in Chapter 10, “Plug-ins”.

Opens the Options and Settings dialog box that enables i
you to modify a range of Client settings. For more

information, see Chapter 9, “Options and settings”.

Click the option to...

Access a list of the icons used in the
BackupVault Client and their meanings.

Access the Product Help.

Access the product information and support
contact details. Also displays any plug-in
version inconsistencies.

Options

Menu/Button
Help
Icon Legend ) C
[
Product Help &
About Redstor Backup P| ©
E Restore Logs @
LX)
C
|
Bin (€
i ¢
"

s and Settings [

?

Help

Remote Management

» Export Backup Snapshot
) Import Restore Snapshot

Email Notification

File (not selected)
Incuded by user
Induded by user filter
Excuded by user
Excluded by user filter
Exduded by administrator
Induded by profiling
Induded by profiling filter
Excluded by profiling
Mandatory included file

Copyright © Blueraq Networks Ltd. All rights reserved



& BACKUPVAULT

Tabs

There are three tabs available in the Backup Client:

e Backup Selection: This tab displays the files and folders on
the computer, enabling you to select the items to be backed
up. For more information, see How fo select data to data back
up in Chapter 6, “Backups”.

o Restore: Use this tab to browse previous backups and
restore files and folders.

e Logs: Use this tab to view detailed information on each
backup and restore.

Product Help

Help

I B Backup Selection g gesmrel = Logsl
C] File

£ L

Tip: In the right-hand pane on the Backup Selection and
Restore tabs, you can click any of the column headings to
sort the list according to their values.

- My Computer

= -

SRecycle.Bin

_ PerfLogs

_ Program Files

_ Program Files (x86)
_ ProgramData

_ Recovery

_ Svstem Volume Information

As you navigate the Client, the Help pane will display information relevant to the selected tab.

7 Product Help

Help index

Quick-start
Step-by-step quide

Backups: How to...
Select data

Use selection filters

Export a selection report
Back up manually

Schedule automatic backups
Cancel a backup

Restores: How to...
Restore files and folders
Find particular files to restore

¢ Product Help

Restore the backup selection

Status bar

This area displays the date and time of the last backup performed by the system.

Restoring files and folders

You can restore files and/or folders in th

steps:

1. Select data to restore

2. Start the restore process
3. Select the restore options

Selecting data to restore

You can tell the Backup Client which files
and/or folders to restore and which to ic

by dicking the ' Restore tab and the
including or exdluding the items as descr

below.

"
’ | Ready

Last backup:Jan 18, 2010 2:55:31 PM

[Lm | »

FAVANAVAVANANANAWANAW AW

SRecycle.Bin
AMD

ATI

Intel
MSOCache
PerfLogs
Program Files
Program Files
ProgramData
Recovery
System Volum

Tamn

You can access the Backup Client Help by clicking Product Help on the Help menu. Alternatively,
.“ click the Help button on the toolbar.
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System tray icon
e The System tray icon indicates the backup activity status and can be used to perform various tasks.
¢ An animated icon indicates that the service is busy with a backup process.

e Click or right-click the system tray icon to view the menu options available.

Open

Backup Now

Cancel Backup
Monitor Status
Notifications 4

About

Exit

Note: On the Windows 7 operating system, the system tray icon is hidden by default. To display the
@ icon, click the Show hidden icons arrow, click Customize. In the dialog box that appears, expand
the Behaviours drop-down next to SERunner.exe, and then select Show icon and notifications.

System Tray menu

Options Click the option to...

Opens the BackupVault Backup Client application window.

Open
Q Tip: Users can also double-click the system tray icon to open the application
window. For more information, see “The GUI explained” earlier in this chapter.
Backup Now Manually initiates the backup process without opening the Backup Client application window.

If the service is busy with a backup (when the System Tray icon is animated), Cancel will stop the

Cancel Backup
process.

Opens a small window above the system tray that enables you to monitor the status and progress of

ST S ETE the task being performed without opening the application window.

Provides you with options to enable/disable backup notifications. For more information, see

AEHHEEIENS “Notifications” later in this chapter.

About Displays the splash screen. Click anywhere in the window to close it.

Removes the icon from the System Tray.
Exit @ Note: This will not stop the BackupVault service from running scheduled
backups.

To see the icon in the system tray again, simply open the BackupVault Backup Client using the
Windows Start button. For more information, see “Opening the Backup Client” earlier in this chapter.

29

Copyright © Blueraq Networks Ltd. All rights reserved



& BACKUPVAULT

Warning: The Backup Service must be running at all times for backups (manual or scheduled) to
take place.

Note: To stop or start the Backup Service, open Administrative Tools in the Control Panel, and
then double-click Services. In the list of services that appear, select BackupVault SE and select
Stop or Start on the toolbar. The System Tray icon will indicate when the service is not running.

Notifications

Notifications of Backup Client activity will appear as pop-ups in the System Tray.

The following notifications will appear by default but can also be disabled: Open
1. When a backup completed successfully. Backup Now
2. When a backup failed to complete. Cancel Backup
3. When a backup was completed but Monitor Status
there were warning or errors. @ % MNotify on Success Motifications 4
@ v Notify on Failures About
@ v Notify on Warnings Exit

Tip: To view related log file information, click anywhere within the pop-up.

Note: You will always be notified if the Backup Client has been upgraded.

To enable or disable notifications:

Right-click the System Tray icon and then enable or disable the check mark next to the relevant Notifications
option.

Tip: Since notifications only appear briefly, hover over the System Tray icon to see when the last
backup occurred.
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6. Backups

After installing BackupVault Server Edition (SE) and creating a Backup Account, you can tell the Backup Client
which files and/or folders to back up and which to ignore by creating a backup selection (see “Selecting data to
back up” below). You can then start a backup manually or schedule automatic backups (see “Performing a
manual backup” and “Scheduling automatic backups” below).

@ Note: Any changes, additions or deletions to included files and folders will be backed up intelligently
with every manual or scheduled backup.

How to back up

The following sections describe how to:
e Select data to back up
o Use filters to specify files and/or folders to be excluded from the backup selection
o Determine the backup selection size
e Export a selection report
e Start backups (automatically and manually)
e Cancel a backup

e Resume a failed or cancelled backup

Selecting data to back up

You can make your first backup selection or modify a backup selection at any time using the Backup Selection
tab as described below.

Q Tip: You should exclude the Backup Client installation folder, as including it increases the size of
- your backup unnecessarily.

To select files and folders for backup:

1. Click the Backup Selection tab.
2. In the Backup Selection tree, navigate to the folder or directory containing the file or folder.

3. Include or exclude files and/or folders, as described below.

Q Tip: Once a file or folder is included in the backup selection, any modifications to it will be backed up
automatically. For more information, see Patching in Chapter 9, “Options and settings”.
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Warning: If you have limited space on the drive running the Backup Client, it is recommended that
you move the Cache, Logs and Temporary folders as well as the selection database to another
location. For more information, see Disk Usage in Chapter 9, “Options and settings”.

To include an individual file:

In the right-hand pane, click the file icon © or right-click the file name, and then click Include. An included file is
displayed with a green icon: ©.

To deselect a file, you can either click the icon again or right-click the file name, and then click Deselect. A folder
containing some included files is displayed with a green tinted icon: £

To include an entire folder:

Right-click the folder icon L, and then click Include Folder. Alternatively, you can select the folder in the
Backup Selection tree, and then click Include Folder on the Selection menu. Included folders are displayed with
a green icon: L.

@ Note: All files in the included folder and its subfolders will be included in the next backup. Any
changes made within this folder or its subfolders will automatically be included as well.

To deselect a folder:

Right-click the folder icon, and then click Deselect Folder.

To exclude a file or subfolder:

If an entire folder is included but you wish to exclude a particular file or subfolder, right-click the file or folder
icon, and then click Exclude or Exclude Folder. Excluded items are displayed with red icons: & or €7 Included
folders that have some files or subfolders excluded are green with a red tint: £ .

Tip:

Q e You can create different backup selections for different backup sets. For more information,
see Multiple backup sets in Chapter 9, “Options and settings”.

e You can use filters to automate file selection based on file types.

e Once you have selected all files to be included and excluded, it may be useful to check the
size of your backup selection before initiating your first backup. For more information, see
Using filters later in this chapter.

Note: Some files and directories are forcefully excluded from the backup selection. On Windows
@ machines, these are the pagefile.sys and hiberfil.sys files; and the Backup Client cache and
toBackup folders.

Using filters

You can use filters to automate file inclusions or exclusions within a folder, based on file types.
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% Example: A *.doc filter will include or exclude all Word documents within a folder, as well as any
new Word documents that are added to that folder later.

To apply a predefined filter to a specific folder:

1. In the Backup Selection tree, right-click the folder icon.

2. Point to Filters.

3. Point to one of the available filters in the list (e.g. MS Office documents).
4

Click Include or Exclude.

To modify an existing filter:
1. In the Backup Selection tree, right-click the folder icon, point to Filters, and then click Edit filters.
2. Select one of the filters and then modify its properties in the Edit filter box.

3. Click OK.

Q Tip: To add a new filter from within the Edit filters dialog box, click the New button, supply a name
that describes the filter, enter the file type(s), and then click OK.

To add a new filter via the Backup Selection tree:
1. Right-click the folder icon, and then click New filter.
2. Inthe Filter name box, type a name to be used in the Filters menu.
3. In the Filter box, specify the file extensions to which the filter will apply.
4. Click OK.
The filter will be added to the Filters menu and you will be able to use it to include or exclude all files matching its

criteria.

To remove filters from a folder:

1. Right-click the folder icon.
2. Point to Filters.
3. Point to the name of the filter you wish to remove.

4. Clear the check mark next to the selection (Include or Exclude).

To identify files and folders selected by filters:

Look at the icon state. Files and folders included in the backup selection by filters display with icons containing
blue check marks: @ and £+

Inclusions and exclusions by “profiling”

Some inclusions and exclusions are enforced at administration level on the Storage Platform. This is called
“profiling”. For more information, see Profiling in Chapter 9, “Options and settings”.
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Files and folders affected by profiling display with the following icons:

Icon Status

C File inclusion
v Filtered file inclusion
(% File exclusion

Folder inclusion
v Filtered folder inclusion

Folder exclusion

Note: Profiled selections cannot be modified from within the Backup Client and can only be changed
on the Storage Platform. For more information, please refer to the Storage Platform Console User
Manual.

Global exclusions

Global exclusions enable you to specify files and/or folders to be excluded from the backup selection.

To add Global Exclusions:

1. Click the Options button on the toolbar, and then click Global Exclusions.

2. Select the type(s) of filters to apply and then specify their values. (For more information, see Global
Exclusions in Chapter 9, “Options and settings”.)

3. Click OK.

Icon legend

On the Backup Selection tab, each file and folder is displayed with an associated icon. The colour of the icon
indicates the file or folder’s backup selection status.

B Backup Selection | B F_lestorel = Logs|
& My Computer ] Filename /
E\"'{‘q’ C: L: 7_zlp
[+ $Recyde.Bin (¥ ATI
-5 AMD [ v ATI Technologies
G-y AT (¥ Attix5Pro
G- Intel [ ¥ Common Files
G- [(¥ MSOCache > CoreTemp
-7 PerfLogs (¥ DVD Maker
& kv | v InternetExplo...

The following icon legend lists the BackupVault icons and the statuses they indicate. You can access this legend
by clicking lcon Legend on the Help menu.

Note: For more information on backup selections (inclusions and exclusions), see “Selecting data to
back up” earlier in this chapter.

Icon legend
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Icon

Status

File (not selected)

Selected by user

Selected by user filter

Excluded by user

Excluded by administrator

Included by profiling

Included by profiling filter

Excluded by profiling

Folder (not selected)

Some files included by user

All files selected by user

All files selected by user, some
excluded

All files excluded by the user

Filter applied by user

Filter applied by user, some
excluded

All items included by profiling

Filter applied by profiling

Filter applied by user, all items
excluded

Description

The file exists in the folder or directory but is not included in the backup
selection (neither included nor excluded).

The Backup Client user has included the file in the backup selection.

The Backup Client user has applied a filter to the parent folder or
directory. That filter has included the file in the backup selection.

The Backup Client user has excluded the file from being backed up to the
Storage Platform.

The Backup or Storage Platform Administrator has excluded this file or its
file type. Files displaying this icon will not be backed up to the Storage
Platform.

The Backup or Storage Platform Administrator has included this file or file
type. Files displaying this icon will be backed up to the Storage Platform
and cannot be deselected from within the Backup Client.

The Backup or Storage Platform Administrator has applied a filter to the
parent folder or directory. That filter has included the file in the backup
selection. Files displaying this icon cannot be deselected or excluded from
within the Backup Client.

The Backup or Storage Platform Administrator has excluded this file or its
file type. Files displaying this icon will not be backed up to the Storage
Platform and cannot be included in the backup selection from within the
Backup Client.

The folder exists in the directory but it is not included in the backup
selection.

The Backup Client user has included some files or folders in the backup
selection.

The Backup Client user has included all files in the backup selection.

The folder contains no unselected files. Each file is either included or
excluded.

The Backup Client user has excluded all files in the folder from being
backed up to the Storage Platform.

The Backup Client user has applied a filter to the folder. The filter has
included one or more files within the folder or sub-folders.

The Backup Client user has applied a filter to the folder that has included
and excluded files within it.

The Backup Administrator has included all the files contained in the folder.
All files will be backed up to the Storage Platform. These inclusions
cannot be changed by the Backup Client user.

The Backup Administrator has applied a filter to the folder. This filter
cannot be removed by a Backup Client user.

The Backup Client user has applied a filter to the folder, resulting in the
folder being excluded from the backup selection.
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Icon

fv

I

19

(i)

Status

Filter applied by profiling, some
items included by user

Filter applied by profiling, some
items included and some items
excluded by user.

Filter applied by profiling but
items excluded by user.

Folder excluded by Global Filter.

All items (files, folders, etc.)
excluded by profiling

Plug-in node (not selected)

Some items selected by user

All items selected by user

All items selected by user, some
excluded

All items excluded by user

Filter applied by user

Filter applied by user, some
excluded

Note: For more information, see “Inclusions and exclusions by ‘profiling

Description

The Backup Administrator has applied a filter to this folder using profiling
and some items have been manually included by the Backup Client user
(see “Selecting data to back up” earlier in this chapter).

The Backup Administrator has applied a filter to this folder using profiling.
Some items have been excluded and others included by the Backup
Client user (see “Selecting data to back up” earlier in this chapter).

ltems in the folder have been included using filters (see “Using filters”
earlier in this chapter.)

The folder has been excluded using Global Exclusions.

The Backup Administrator has excluded all files in the folder and sub-
folders. These excluded files cannot be included by a Backup Client user.

The plug-in exists but is not selected for backup to the Storage Platform.

The Backup Client user has selected some of the items in the plug-in for
backup to the Storage Platform.

The Backup Client user has selected all items in the plug-in for backup to
the Storage Platform.

The Backup Client user has included and excluded items in the plug-in.

The Backup Client user has excluded all items in the plug-in from being
backed up to the Storage Platform.

The Backup Client user has applied a filter to the plug-in; specifying that
certain file types must be included for backup to the Storage Platform.

The Backup Client user has applied a filter to the plug-in; specifying that
certain file types be included for backup to the Storage Platform but some
items have been excluded either through the use of an exclusion filter or
by manual exclusion.

E

in Chapter 6, “Backups”

and plug-ins in Chapter 10, “Plug-ins”.

Determining the backup selection size

It is useful to determine the backup selection size before starting the backup process to avoid Over Limit errors.

(i)

To calculate the backup selection size:

Note: The Backup Client compares your backup selection size with the Backup Account limit
(specified by your Backup Administrator) at the beginning of the backup process. If the selection size
exceeds the Account limit, the backup process will stop and an Over Limit error message will be

displayed.
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A. On the File menu, click Calculate Size.

B. Alternatively, click the Size button on the toolbar:

t1EIX2 Q|0 Q|2

Backup Sze Restore Find Options  Automate Help

The Backup Selection Size dialog box that appears displays total size of your backup selection (i.e. all files
included for backup).

Backup set index preparedin < 1s
Files and directories: 1 Total size: 24 bytes
Mandatory files: 0 Total size: 0 bytes

Warning:

e Ifyour backup selection size exceeds your Backup Account limit, you need to remove some
items from the selection or ask your Backup Administrator to upgrade your Backup Account
limit.

e Ifa backup fails and an Out of Memory error message is recorded in the backup log, you

need to increase the default amount of server memory you wish to allocate to the backup
service.

To remove a file from the backup selection:

A. In the Size dialog box, right-click the file’s icon: ©. The icon will turn red to indicate that it is excluded: &

Note: To exclude multiple files at once, click a file name in the list, hold down the Shift key
and drag the mouse pointer to highlight the files. Right-click the selection, and then click
Exclude.

B. Alternatively, on the Backup Selection tab, deselect or exclude files or folders that are currently
selected for backup. For more

) . . € C\Users\User\Documents\Backup selection.html - Windows Internet Explorer ol -@-|==]
Informatlon’ see SeIeCtlng data to QQ ‘Q CAUsers\User\Documents\B v [ 5 [ X Hb Bing »p -
baCk up in Chapter 6’ BaCkupS . ¢ Favorites | 5k @ Suggested Sites v @] Web Slice Gallery v
@ C\Users\User\Documents\Backu... 0 v B v [ d=® v Pagev Safetyv Toolsv @~ ”
Exporting a selection report A
. . Backup Account: BACKUP ACCOUNT 01
After Creatlng a baCkup SeIeCtlon’ you can Backup Group: A-SP OWNER\RESELLER A\BACKUP ACCOUNTS
export a list of all backup inclusions and Storage Platform: 192.168.20.215
. . Backup Set Name: Default L
exclusions to an html file for future Backup Set Version: 6.0 |
reference Client Version: 6.0.0.685
The selection report will specify: Schedule

Daily backups for this backup set occur at 11h04
e Files and folders included in the

backup

No advanced schedule is defined.

Selections

Overview

There is 1 volume with selections:

o CiY
o 1 folder directly included
o 1 folder directly excluded
o 1 file directly included -
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e Files and folders excluded from the backup
e How each item was selected (user-selected, filters, profiling, global exclusions or mandatory patching)
e Where each item is located on the machine

e The total number of items in the backup selection

To export a selection report:

1. On the File menu, click Export Selection.

2. In the Save As dialog box, select the location in which to save the file, type a file name in the File
name box, and then click Export.

The file will be saved to the specified location and can be viewed in any Internet browser.

Starting a backup manually

Tip: Run a backup manually after creating your backup selection to ensure immediate data
Q transmission to the Storage Platform. Thereafter, automatic backups will ensure hassle-free
continuous backups. For more information, see “Scheduling automatic backups” later in this chapter.

To start a backup manually:

1. On the File menu, click Backup Now. Alternatively, click the Backup button on the toolbar.

'.

Backup

The Backup dialog box appears and displays the progress of the backup:

n Backup -

| Sending index file

Starting MS SQL Server Backup. A
Building selection list

[MS SQL Server Plugin] Done. 0 database(s) exported.

Total selection: 464 bytes in 2 files and 2 folders

Estimating backup size

Data to be processed estimated at 463 bytes

Volume Shadow Copy is enabled

Starting VSS snapshot

If multiple backup sets are enabled and their backup windows overlap, a backup queue will display in the
Backup dialog box, enabling you to cancel the current backup in favour of the next, should you wish to
do so. For more information, see Multiple backup sets in Chapter 9, “Options and settings”.

2. To close the Backup Client after the backup process has started, click the Hide button. This will not
cancel the backup process and the Backup Client can be re-opened at any time to view the progress of
the backup.
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Tip:

e You can monitor the backup progress at any time by right-clicking the system tray icon and
then clicking Monitor Progress.

o To view backup logs, click the Logs tab. Backup log dates are displayed in blue.
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Scheduling automatic backups

Automatic backups are usually enabled and configured either during the Setup Wizard or during the Backup
Wizard but you can enable and schedule them at any point in time using the Options and Settings dialog box.

To schedule a daily automated backup:

1.
2.
3.

On the Tools menu, click Options. Alternatively, click the Options button on the toolbar.
In the Options and Settings dialog box, click Backup Schedule.

If multiple backup sets are enabled, ensure that the correct set is selected in the Backup set drop-down

box. (For more information on backup sets, see Multiple backup sets in Chapter 9, “Options and
settings”.)

Select the Daily automated backup check box, and then specify a backup time in the associated box.
Click OK.

To create an advanced backup schedule:

1.

o &~ e

Backups will initiate at the scheduled times and the | gy Backup -
Backup dialog box will appear displaying the
progress of the backup:

Select the Advanced schedule (back up at the following times) check box.

In the Week day box, select the day on which a backup should be initiated.

Specify the time in the Backup time box.

Click the Add button to add the day and time to the Advanced schedule box.

Repeat steps 2 to 4 above until you have added all desired schedules to the Advanced schedule box.
Tip:

e You are advised to back up at night when the server running the Backup Client is not in use.

It must be switched on at the scheduled backup time(s), but the Windows user does not
need to be logged in.

e Configuring automatic backups ensures that all selected data is backed up automatically,
without the need for any user interaction. This is a safer alternative to relying on manual
backups.

T
]
r

D

Starting MS SQL Server Backup. A
Building selection list

[MS SQL Server Plugin] Done. 0 database(s) exported.

Total selection: 464 bytes in 2 files and 2 folders

Estimating backup size

Data to be processed estimated at 463 bytes

Volume Shadow Copy is enabled

Starting VSS snapshot

Tip:

e To close the Backup Client after the backup process has started, click the Hide button. This

will not cancel the backup process and you can re-open the Backup Client at any time to
view the progress of the backup.

e You can monitor the backup progress at any time by right-clicking the system tray icon and
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then clicking Monitor Progress.

o To view backup logs, click the Logs tab. Backup log dates are displayed in blue.

Backups will be stored on the Storage Platform and accessible via the Restore tab. For more information on
restoring data, see Chapter 7, “Restores”.

Multiple backup sets

If multiple backup sets are enabled and their backup windows overlap, a backup queue will display in the
Backup dialog box, enabling you to cancel the current backup in favour of the next, should you wish to
do so. For more information, see Multiple backup sets in Chapter 9, “Options and settings”.

Cancelling a backup

Once a backup is in progress, you can cancel the process via the Backup progress window or using the system

tray icon.

To cancel a backup:

1. Perform one of the following actions:

a)

b)

In the Backup progress window, click the Cancel button.

I Sending backup

Connecting to service

Starting backup

Building selection list

Total selection: 570 bytes in 2 files and folders

Starting ¥SS snapshot

Checking for differences

Total backup size: 171 bytes

Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.245:443
Server name: Storage Platform, AttixS Dev QA,

[ Server name: Storage Platform, AttixS Dev QA,

[ Cancel ,\‘L\[ Hide ]

Alternatively, you can right-click the runner icon in your system tray, and then click Cancel.
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Open

Backup Now

Cancel Backup
Manitor Status%
MNotifications »

About

Exit il
e 7/23/2010 |

2. In the confirmation dialog box that appears, click Yes.

Resuming a backup

By default, the Backup Client tries to connect to the Storage Platform four times before cancelling the backup
process. If, however, the previous backup was not successful and a manual backup is initiated, the Backup
Client will display the prompt: “Do you want to resume the failed backup...?” with a 30 second countdown.

o~ ™

Confirm resume backup @

Do you want to resume the failed backup from Tue 19 Jan 2010, 18:51:507
(A new backup will start in 28 seconds)

| Yes ] [ No ] [ Cancel

e Click Yes to instruct the Backup Client to try to continue from where the process failed during the
previous backup,

e Click No to initiate a new backup or

e Cancel to return to the Backup Client application window.

Note:
e You can only resume a backup if the backup completed the Processing stage.

e A new backup will be initiated automatically after the countdown has elapsed.
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7. Restores

On the Restore tab, you can browse a tree structure representation of all successful backups and their files and

folders.

How to restore

The following sections describe how to select data to restore, start the restore process, and search for specific
backed up files.

Selecting data to restore

B Backup Selection| [ Restore Logs

On the Restore tab, the Restore tree gives you access to backed up files

|Backups

— via two main nodes: Last Backup and Previous Backups.

-4 LastBackup (8 Oct 2012, 17:53:57) The Last Backup node contains the file/folder structure of the last
T ff Users successful backup and displays the date and time it occurred in
. fk Workspace parentheses “()".

-4 _ Previous Backups
Bl 08 Oct 2012, 14:57:33 Note: Restores done from the Last Backup node are typically
-4 04 Oct 2012, 19:00:07 @ faster than those done from the Previous Backups node as
iy t gi gz: ;gg izfggfg; the Backup Client may be able to retrieve the data from the
5 L:l 30 Sep 2012, 19:00:05 cache instead the Storage Platform.
G- 29 Sep 2012, 19:00:02 When you expand the Previous Backups node, the Backup Client

retrieves the list of previous backups from the Storage Platform and displays them in the tree.

To select and restore data from the last backup:
1.

2.

3.

Click the Restore tab.
Expand the Last Backup node to view the files/folders.

Include a single file by clicking the © icon next to the file or by right-clicking the file name and then
clicking Include. Each included file is displayed with a green icon: ©.

Include an entire folder by right-clicking the folder and then clicking Include folder. Each included folder
is displayed with a green folder icon: £

If an entire folder is included but you wish to exclude a particular file or subfolder, right-click the file or
folder icon, and then click Exclude or Exclude Folder. Excluded items are displayed with red
icons: ® or £7. Included folders that have some files or subfolders excluded are green with a red
tint: £

Once all the files and folders to be restored are selected, start the restore process by clicking Restore
on the File menu or the Restore button on the toolbar. For information on the restore options available,
see “Restoring data” later in this chapter.

To select and restore data from previous backups:
1.

Click the Restore tab.
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Expand the Previous Backups node to connect to the Storage Platform and retrieve a list of all previous
backup dates.

Expand the relevant backup node, and then click the folder/directory containing the data.

Include a single file by clicking the © icon next to the file or by right-clicking the file name and then
clicking Include. Each included file is displayed with a green icon: ©.

Include an entire folder by right-clicking the folder and then clicking Include folder. Each included folder
is displayed with a green folder icon: L.

If an entire folder is included but you wish to exclude a particular file or subfolder, right-click the file or
folder icon, and then click Exclude or Exclude Folder. Excluded items are displayed with red
icons: ® or £7. Included folders that have some files or subfolders excluded are green with a red
tint: £

Once all the files and folders to be restored are selected, start the restore process by clicking Restore

on the File menu or the Restore button on the toolbar. For information on the restore options available,
see “Restoring data” below.

Restoring data

After you have selected the files and folders to restore, you can start the restore process as described below.

To start the restore process:

1.

On the File menu, click Restore. Alternatively, click the Restore button on the toolbar:

t 2ldlalo @ ?

B s -

Backup Sze Restore Find | Options Automate Help

The Restore dialog box will prompt you for a restore location:

Restore files to...

[us]

Folder: |C:\Users\User\Restore

@) Original location

Select Original location to restore the files to the same location that they were backed up from or select
Folder and then browse to a new location.

Warning: If Original location is selected, the restored files will overwrite any existing files
with the same name in that location. A warning will, however, be displayed before the
Backup Client overwrites any files.

In the I want... section, select either the fastest restore (no resume possible) or to resume interrupted
transfers depending on your requirements.
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Iwant...
@ the fastest restore (no resume possible)

") to resume interrupted transfers

Restore straight to target location without using any temporary local
disk space. However, the restore cannot be resumed if it is interrupted.
Switable for local (LAN) restores.

4. Click the Show advanced options... link to display the advanced restore options. You can now specify
the rest of the restore options by selecting or clearing the following check boxes:

Advanced options
(V| Recreate folder structure
|| Restore empty folders
|| Restore file and folder permissions

(] Overwrite files

Hide advanced options...

a. Recreate folder structure — This option is selected by default. It instructs the Backup Client to
recreate the folder structure in the restore folder. Clear this check box if you wish to restore the
files to a single folder.

@ Note: If restoring files from different folders with the same file names, you need to
recreate the folder structure to prevent overwriting the files

b. Restore empty folders — If the Recreate directory structure option is selected, you can select
this check box to recreate empty folders.

@ Note: This option is only available when Recreate directory structure is selected.

c. Restore file and folder permissions — Clear this check box if you do not wish to restore the file
and folder permissions. You would typically only select this option after a complete server failure
(to restore files before user accounts are re-created).

d. Overwrite files — Select this check box if you do not want the Backup Client to prompt you
before overwriting an existing file.

5. Click Restore.

@ Note: You can view restore logs on the Logs tab. Restore log dates are displayed in green.
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Finding files in backups
To find a specific backed up file, it may be easier to use the Find function than to browse the Restore tree.
You have the option to scan only your last backup (locally), or you can connect to the Storage Platform and

search through previous backups.

To search for a file in your latest backup:

1. On the File menu, click Find Files in Backups. Alternatively, click the Find button on the toolbar:

lli VI O ?

Backup Sze

Find Options  Automate Help

2. Type the file name or part thereof in the File name box, and then click Find.

File name {full or partial): sales|

@ Search last backup (local)

() Search through previous backups (Storage Platform)

Search backup dates

[ Limit number of results to: |10

Example: If “sales” is searched for, the Backup Client will display a list of all files in the last backup
containing “sales” in the filename.

Tip: Use the * and ? wildcards for advanced search queries.

To search for a file in previous backups:

1. On the File menu, click Find Files in Backups. Alternatively, click the Find button on the toolbar:

1|i V1 O ?

Backup Size

Find Options  Automate Help

2. Type the file name or part thereof in the File name box.

3. Select the Search through previous backups (Storage Platform) check box.
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File name (full or partial): sales

() Search last backup (local)

@ Search through previous backups (Storage Platform)

Search backup dates

Start date: E] MM-dd-vyyy
End date: E] MM-dd-vyyy

Limit number of results o |10

4. If you wish to limit the search to particular dates, select the Search backup dates check box and then

use the Start date and End date boxes to specify a time period.

5. To limit the number of results that display, select the Limit number of results to check box and then
type a number in the box provided.

6. Click Find.

Tip: Use the * and ? wildcards for advanced search queries.

Note: If Search backup dates is selected, the backup date is used for the search instead of the
file created or file modified date.

To restore files from the Find Files in Backup dialog box:

1. In the search results list, include the files to restore by clicking the icons next to the file names or by
right-clicking each file name and then clicking Include.
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File name (full or partial): |sales

@ Search last backup (local)

() Search through previous backups (Storage Platform)
Search backup dates

[ Limit number of results to: |10

Search result

. | Folder | Filename |s.. | pate |Fi.. |Back.. |
© C:\Users\Bashier... salesMov2009,txt 0KB 19/01/20... txt 19/01/20...
iC:\Users\Bashier. .. salesJan2010.kxt 0KB 19/01/20... txt 19/01/20...
) C:\Users\Bashier... salesDec2009.txt 0KB 19/01/20... txt 19/01/20...

| Restofe

2. Click the Restore button.

The Restore Options dialog box will appear, enabling you to specify the location in which to save the restored
files. For more information on restore options, see “Selecting data to restore” earlier in this chapter.

Restoring a backup selection

By default, with every backup performed, a copy of the backup selection is saved on the Storage Platform. For
more information on backup selection, see “Selecting data to back up” earlier in this chapter.

This enables you to restore, not only your backed up files and folders, but the selection you used to back them
up as well.

Note: This is especially useful in disaster recovery cases, as it enables you to restore your entire
backup setup to perform exactly as it did at the last backup.

To restore a backup selection:

1. Click the Restore tab.

2. Expand the relevant backup folder, and then click the Workspace node.

I B Backup Selectionl B Restore | [ Logs
B Backups
EJ 4 LastBackup (8 Oct 2012, 17:59:57)
: Bb_ C:
. @4 Users

E}L, Previous Backups
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3. In the right-hand pane, click the icon next to the name of the backup set to include it for restore. If you
have not enabled multiple backup sets (see Multiple backup sets in Chapter 9, “Options and settings”),
include the only entry that displays.

Filename

& Include
& Exclud
) Deselect

4. Click the Restore button on the toolbar.
5. Select the appropriate restore options. (See “Selecting data to restore” earlier in this chapter.)
6. Click Restore.

The backup selection will be restored to the location specified in the restore options.

Restoring archived data

BackupVault allows Backup Administrators to archive Backup Clients’ data to tape or another disk drive using the
Hierarchical Storage Management (HSM) feature. Once data has been archived, the backups will display in the
Restore tree as greyed out folders, allowing you to browse the file/folder structure of the backups. However, if
you try to restore archived data, you may receive a message informing you that the data has been archived to
secondary storage, as illustrated in the screenshot below.

=14 Last Backup (3 Aug 2010, 12:50: ® utoexec.bat .

[ C:‘ ) bootmgr
{ _ Program Files ) BOOTSECT.BAK
ik vsS Writers € MSDOS.5Y5

g Workspace
=4 Previous Backups
|~ 03 Aug 2010, 12:21:54
L 23 30 2010, 15:56:25 |
=8 123 J2010, A 0104 i 0' This data has been archived to secondary storage
. ' and removed from the Storage Platform. To restore any of these files,

please contact your backup administrator and request
to have the files moved back to the Storage Platform.,

{7 VS5 Writers —
{7 Workspace

Note: Grey folders indicate archived data. However, if you do not see these folders in the Restore
@ tree, it does not mean that no archived backups are available. In such cases, please consult your
Backup Administrator for further details about archived backups.

You can access archived data by requesting that your Backup Administrator import the HSM data to the Storage
Platform. Once the data has been imported, it will be available for restore in the same manner as all other
backups.
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8. Logs

The Backup Client logs all backup and restore processes and their results in log files that you can view on the
Logs tab. The following sections describe how to access log files and modify their settings.

Accessing log files

The Logs tab in the Backup Client provides detailed information about each backup and restore. An additional
toolbar button appears when the Logs tab is opened: the Summary button. Use the button to view only errors
and warnings and the last 14 lines in the log file.

Q Tip: You can use the Up arrow, Down arrow, Page Up, Page Down, Home and End keys to
navigate the log.

Changing log file settings
You can specify your logging preferences on the Logging page in the Options and Settings dialog box.
Modifiable settings include:

e level of detail included

e date inclusion/exclusion in time stamp

¢ log file retention period

For information on configuring the log file settings, see Logging in Chapter 9, “Options and settings”.

9. Options and settings

To access the Options and Settings dialog box:

e On the Tools menu, click Options.

e Alternatively, click the Options button on the toolbar:

- v
' =3 — N i \/ H
Backup Size Restore Find Options  futomate Help

The various options and settings are grouped in the left-hand pane according to their functions. Click an item on
the left to view the full set of options related to that function.

ﬁ Example: Click Connection in the left-hand pane to view all connection options on the right:
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Connection Type

(@ Use network connection

(7) Use VPN or dial-up connection

l VPN and dial-up settings...

Advanced Communications Proxy Server
@ No proxy

(©) Use HTTP proxy
(©) Use SOCKS proxy

Proxy host: l Proxy port:

O Proxy server requires authentication:

P — P E—

(o J[ concel J[_ tep ]

Warning: The Options and Settings dialog box controls advanced features in the Backup Client.
Please read through this section carefully before changing any settings. Incorrect settings could
cause critical errors.

Backup Account
You can use the Backup Account page in the Options and Settings dialog box to:
o Retrieve Backup Account settings

e Modify security settings
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s Detil
Storage Platform: 2650D
Connection Backup Account limit: ~ 50.0 GB
Connection Throttle Retrieve settings
Advanced Communications .
Security
I fority [ Change password ]
[ Change encryption key ]
Compression
Patching Prompt for password:
@ Never (default)
Disk Usage
(©) When doing a restore
Advanced Performance -
() When loading the Backup Client

The Backup Account page consists of the following areas:

e Details
e Security
Details area

This area displays your Backup Account information as it is configured on the Storage Platform. You can use the
Retrieve settings button to retrieve your Backup Account details from the Storage Platform.

Tip: This button is useful to verify that the Backup Account limit has been modified after requesting a
change from the Backup Administrator, or to update Backup Group Profiling settings.

Security area

If you need to change your password or encryption key, click the Change password or Change encryption key
buttons.

Warning:

e Changing the encryption key involves intensive processing on the Storage Platform and may
take several minutes. You should avoid doing this unless the encryption key has been
compromised.

o Disaster recovery is not possible without the encryption key. Please ensure that this key is kept
in a safe place. THIS ENCRYPTION KEY IS NOT STORED ON THE STORAGE PLATFORM
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AND CANNOT BE RECOVERED OR RESET IF LOST.

You can select whether or not the Backup Client should prompt for the Backup Account password. Three options
are available:

e Never (default): The Backup Client remembers the Backup Account password when doing a backup or
restore.

e When doing a restore: The Backup Client prompts for the Backup Account password when opening the
Restore tab.

e When loading the Backup Client: The Backup Client prompts for the Backup Account password when
opening the Backup Client and the Restore tab.

Backup Schedule
You can use the Backup Schedule page in the Options and Settings dialog box to:
e Enable/disable a daily automated backup

e Create advanced automatic backup schedules

Backup Schedule

Automatic Backups

Backup set: O . [ |
Daily automated backup @ | 19h00 |

Connection

Advanced schedule (back up at the following times):
Connection Throttle Week day Advanced schedule
. Monday Monday@12h00

Advanced Communications Tuesday Backup time:

Thursday
Backup Priority Friday Add

Saturday -
T Sunday Delete
Patching
Disk Usage
Advanced Performance

[ ok J[ cancel |[ hep |

Note: If using multiple backup sets, use the Backup set drop-down at the top of the dialog box to
specify which backup set schedule you wish to configure. For more information, see Multiple backup
sets in Chapter 9, “Options and settings”.

Daily automatic backups are enabled by default unless disabled during the Setup Wizard. If disabled, you can
enable it by following the instructions below.
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To enable a daily automated backup:

1. Select the Daily automated backup check box.
2. Specify a time in the associated box.

3. Click Ok.

To create an advanced backup schedule:

1. Select the Advanced schedule (back up at the following times) check box.
2. In the Week day box, select the day on which a backup should be initiated.

3. Specify the time in the Backup time box.

4. Click the Add button to add the day and time to the Advanced schedule box.

5. Repeat steps 2 to 4 above until you have added all desired schedules to the Advanced schedule box.

To disable automatic backups (not recommended):

1. Clear the Daily automated backup and Advanced schedule check boxes.

2. Click Ok to close the Options and Settings dialog box.

Warning: This option is not recommended. If an automated backup schedule is not
created, backups will have to be run manually. Enabling automatic backups is strongly
advised.

For detailed instructions on how to enable and schedule automatic backups, see Scheduling automatic backups
in Chapter 6, “Backups”.

Global Exclusions

You can use the Global Exclusions page in the Options and Settings dialog box to:
e Exclude files globally
e Exclude folders globally

¢ View profiled global exclusions
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Global Exclusions
Exclude Files
[ Exdude these files:

Examples:
file?.doc
video*.*
*mp3
spedific.avi

[ po not back up files older than: |:|E]
Exclude Folders
[ Exclude these folders:

Examples:
My Music
Data
Photos

Profiled Exclusions
Files or folders:
*mp3
*avi
*.mpg
Videos
My Music

The Global Exclusions page in the Options and Settings dialog box consists of the following areas:
e Exclude Files
e Exclude Folders

e Profiled Exclusions

Exclude Files area

In this area, you can specify that files with certain file names, extensions or last modified dates be excluded from
all backups.

To exclude files based on their file names or extensions:

1. Select the Exclude these files check box.

2. Type the file name(s) and/or file extension(s) in the box provided; separated by semicolons or listed
beneath each other.

Tip: You can use wildcards. E.g. *.mp3 will exclude all MP3 files from backups.
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Example: To exclude all MP3 and AVI files, specify *.mp3 and *.avi in the text box.
Separate entries with a semicolon or type each on a new line.

3. Click OK.

To exclude files based on their 'last modified' dates:
1. Select the Do not back up files older than check box.
2. In the box provided, type the date in dd-mm-yyyy format. Alternatively, click the drop-down arrow and

select a date.

3. Click OK.

Exclude Folders area
In this area, you can exclude certain folders from all backups.

To exclude folders:
1. Select the Exclude these folders check box.

2. Type the folder names in the box provided; separated by semi-colons or listed on separate lines.

Note:
o Wildcards and path separators are not supported in this area.

e FEntries are case sensitive.

3. Click OK.

Profiled Exclusions area
This area will indicate if any file/folder global exclusions have been set by the Backup Administrator. Since
profiled settings can only be changed from the Storage Platform Console, contact your Backup Administrator if

there is a problem with the files/folders being excluded.

Note: Profiled exclusions are combined with the user’s exclusions in the Backup Client. However,
profiled exclusions take precedence over the user’s inclusions.

For more information, see Profiling in the Advanced Tools section later in this chapter.
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Connection
You can use the Connection page in the Options and Settings dialog box to:

¢ Modify Storage Platform connection settings

e Enable/disable/configure proxy server details

Connection Type

(@ Use network connection

(©) Use VPN or dial-up connection

l VPN and dial-up settings...

Connection Throttle

Advanced Communications Proxy Server
(@ No proxy
(©) Use HTTP proxy
(©) Use SOCKS proxy

Proxy host: [ Proxy port:

D Proxy server requires authentication:

Advanced Performance Username: l ‘

Password: l ‘

Lok ][ cancel J[ heo ]

The Connections page consists of the following areas:
e Connection Type

e Proxy Server

Connection Type area

In this area, you can change the type of connection that the Backup Client uses to connect to the Storage
Platform. You can choose between a network or VPN/dial-up connection.

Note: The VPN or dial-up settings... button is enabled if you select Use VPN or dial-up
connection. Click this button to select an existing VPN or dial-up connection configured on the
computer and then supply the username and password for that account.
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Proxy Server area

In this area, you can specify whether or not the Backup Client should connect to a proxy server when connecting
to the Internet. If you select that it should, you can specify the proxy server details in the available boxes.

Connection Throttle

The Connection Throttle page in the Options and Settings dialog box enables you to specify the Backup
Client's bandwidth usage speed limits. You can do this by creating a throttle map. Backup data will then only be
transferred at the specified speed limits during each interval.

Connection Throttle

Speed Limits
Specify backup speed limits for throttle map below (0 means no limit will apply):

Limit 1 - ks umit2 [ kBJs
Limit 3 - ks Limit4 [ kBfs
timit 5 [0 kBfs  Limité - kBfs

1L
%
g

Throttle Map

Backup Priority Selected speed limit: . Interval: minutes

Lo, 10 1z 14 16 18 20 22

T M ([ LT
e [~ ANENENNANERERENNENNENEE
i | | | [ [ [ [ [

[ ANENRNNANERERENEENEENEE
[~ ANENENNANENENENNENNENEE
[ = ANNNNENENENERERERANANANE
[~ ANNNEENNNENENNNNNENANENE

| Clear || Default |

Ok J[ concel J[ hep ]

The Connection Throttle page consists of the following areas:
e Speed Limits
e Throttle Map
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Speed Limits area

In this area, you can specify one or more speed limits (in kilobytes per second) that can be applied when sending
backup data to the server.

To specify a speed limit:

Choose a colour to represent the limit and specify the limit in that colour’s Limit box.

You can now schedule the speed limits in the Throttle Map area as described below.

@ Note: A limit of 0 indicates that no limit will be applied.

Throttle Map area
In this area, you can indicate when the speed limits specified in the Speed Limits area should apply by creating a
throttle map.

Tip: By default, a throttle map is provided with different colours indicating week day office hours, out-

Q of-office hours and weekends (using intervals of 60 minutes). You can either set speed limits for the
colours used in this default map or you can click the Clear button and create a new map by following
the instructions below.

To create a throttle map:
1. In the Interval box, specify the number of minutes that each block in the graph should represent.

2. In the Speed Limits area, click a speed limit colour. Alternatively, click the Selected speed limit box to
cycle between the different limits.

3. In the Throttle Map area, click the schedule interval boxes you wish to apply the limit to. The colour of
the selected interval boxes will change to match that of the chosen limit.

Q Tip: Should you wish to revert to the default throttle map at any point in time, click the
Default button.

4. Click OK.

Advanced Communications

You can use the Advanced Communications page in the Options and Settings dialog box to configure all
advanced communication settings.
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Advanced Communications

Secure Connection

Use secure (SSL-enabled) connections for data transfer (recommended)

Warning: This should only be disabled to enhance transfer speeds after the
network has been confirmed to be secure.

Connection

Connection Throttle Retries and Timeouts

_ Number of backup or restore retries:
— Duration before connection retries: seconds

Backup Priority Socket timeout: seconds
c .
e Concurrent Transfer
Patching
Beain transferring data during the compression phase
Disk Usage
Note: This will result in a shorter backup window but may transfer more data.
Advanced Performance

[ ok J[ concel J[ beb ]

The Advanced Communications page consists of the following areas:
e Secure Connection
e Retries and Timeouts

e Concurrent Transfer

Secure Connection

Use secure (SSL-enabled) connection for data transfer (recommended). This option is selected by default,
enabling SSL encryption for Backup Client-to-StorageServer data transfers. Deselecting this option disables SSL
encryption for data transfer. This enhances transfer speeds but should only be done within a secure network
environment.

Note:

o Disabling this feature will only have an effect on security for the actual data transfer and not
the encryption of the data on the Storage Platform.

e Secure data transfer connections can only be disabled if the StorageServer has been
configured to accept non-secure connections. If the StorageServer cannot accept non-
secure connections, an SSL-enabled connection will automatically be used instead.
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Retries and Timeouts

Number of backup or restore retries

By default, the Backup Client tries to connect to the Storage Platform four times before cancelling the backup
process.

Note: You are advised to increase the number of attempts when using a slow Internet connection.
The backup will continue from the previous point of failure and not resend the entire backup.

Duration before connection retries

By default, the Backup Client will try to reconnect to the Storage Platform after 60 seconds, should the
connection be dropped. This setting enables you to increase/decrease the duration between retries.

Socket timeout

The default socket timeout is 60 seconds. If the Backup Client is connected to the Storage Platform and there is
no communication between the two, the time specified in this box (in seconds) is how long the Backup Client will
stay connected before dropping the connection.

Concurrent Transfer

Begin transferring data during the compression phase

Select this option if you wish to make use of concurrent backup processing to speed up the backup process.
With this setting enabled, the Backup Client compresses/patches files in the background using one thread and
transmits files to the Storage Platform using a second thread as soon as the files are compressed/patched.

Backup Priority

You can use the Backup Priority page in the Options and Settings dialog box to limit CPU usage and disk
access.

Backup Priority

CPU and Disk Access

(@ Normal priority (default)
(©) Run backups in the background

(*) Custom priority (advanced)

Connection Throttle Run backups in the background if it affects other applications.

Advanced Communications
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The Backup Client uses a fair portion of the available processing power to patch, compress and encrypt files
during the backup process. The constant disk access that the backup process requires can also reduce
performance for other applications, although it ensures that the process completes as quickly as possible.

If you use the computer while it is backing up, you might experience some performance deterioration. To lessen
this effect, you can choose to run backups in the background or use custom priority on Windows Server 2008
machines or lower the processor usage and/or disk access on Windows Server 2003 machines.

Windows Server 2008

On Windows Server 2008 machines, a Run backups in the background option enables you to instruct
the Backup Client to run all backups in the background, thereby lowering the disk and CPU usage
priority in Windows and allowing other applications to run faster. Alternatively, you can select Custom
priority (which is an advanced feature) and manually set the processor usage and disk access.

Note: If you use the highest Disk access setting, the Backup Client will continuously use all
available disk access to read and write to the disk, ensuring that the process completes as quickly
as possible. The process will take longer if this setting is lowered but other disk-intensive
applications will perform better.

Warning: If you use the highest Processor usage setting, it will affect server performance during
the backup.

Compression

You can use the Compression page in the Options and Settings dialog box to configure the Backup Client
compression level and exceptions.

Backup Account Compression
p
Backup Schedule Compression Level
Global Exclusions Compression level Projected size Speed
Connection Throttle 2l ’ °7 °
Advanced Communications
_ Note: Projected compression size is an estimation and depends on the type and content of each
file.
Backup Priority
e Cresstonreeptons
Patching Exdude from compression:
Disk Usage = 2ip; *.cab; *.jpg; *.gif; *.png; .mp3; =.mp4; *.mpg; *.mkv; *.rar; *. 7z;*.gz; *.bz2; *.rpm
Example: *.zip;*.jpg
Advanced Performance
Logging

Ok ][ Cancel H Help

The Compression page consists of the following areas:

62
Copyright © Blueraq Networks Ltd. All rights reserved



& BACKUPVAULT

e Compression Level

e Compression Exceptions

Compression Level area

The Compression Level area allows you to change the compression level by selecting the option that best suits
your needs. The Medium (default) compression level provides the fastest speed, but the compressed files will
be slightly larger than those produced using the High or Maximum options.

Compression Exceptions area

The Compression Exceptions area allows you to specify the file types that the Backup Client should not
compress during the backup process.

Tip: Compression is not effective on all file types as some files may already be compressed or

Q cannot be compressed at all. The Backup Client could waste some time and processing power trying
to compress these files. This setting can be used to specify a list of file extensions that should not be
compressed during the backup process. The list of file types already specified are types that
typically do not compress well.

To exclude files types from compression:
1. Select the Exclude from compression check box.
2. Type the file extensions in the box provided, separated by semi-colons.

3. Click OK.

Patching

You can use the Patching page in the Options and Settings dialog box to:
¢ Enable/disable Delta Blocking
e Enable a Binary Patching threshold

e Specify mandatory patching
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Delta Blocking

Enable Delta Blocking for

[/] files larger than: GB
@ or

and

[] files with these extensions: \".edb,‘.mdf I

Note: Delta Blocking is faster than Binary Patching, but generates larger patches and uses more
Storage Platform disk space.

Backup Priority

Binary Patching Threshold

Compression
_ Enable Binary Patching threshold: GB

Disk If 3 file being patched contains a single block of changed data larger than this value, the patch
Usage will be aborted and the whole fie will be transmitted instead.

Advanced Performance
Mandatory Patching

Patch these files with every backup, even if their date and size did not change:

Remove

[ ok J[ concel J[ heo ]

The Patching page in the Options and Settings dialog box consists of the following areas:
e Delta Blocking
e Binary Patching Threshold
e Mandatory Patching

Delta Blocking area

Delta Blocking is an alternative to Binary Patching and compares changes on a block level. It is significantly
faster than Binary Patching and does not require a complete copy of a file in the cache to calculate the patch,
only a footprint file. The footprint file requires very little free disk space - 0,0006% of the original file. However,
depending on the data being backed up, Delta Blocking patches can be larger than Binary patches.

Note: It is vital that you read through this section before enabling this option in your Backup Client.

To enable Delta Blocking:
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1. Select the Enable Delta Blocking for check box.

2. The Delta Blocking file selection criteria can be set in two ways: by file size or file type. Select the
applicable condition(s) and supply the necessary information. Any recently changed files not matching
these criteria will be patched using Binary Patching.

Q Tip: You can enable both conditions by selecting both options as well as the and option.

Warning: Some database files may not be suitable for Delta Blocking since data is shifted at the
beginning of the file. When this happens, it will result in a patch as large as the complete file. It is
advisable to closely monitor the sizes of the patches when Delta Blocking is enabled and disable it if
it turns out to be ineffective.

Binary Patching Threshold area

Binary Patching is the most effective form of patching. It is CPU-intensive but will deliver the smallest patches.
The process is only possible if a complete copy of an older version of the file is available in the cache.

@ Note: Binary Patching is enabled by default and nothing needs to be configured in this area for
normal use.

Enabling Binary Patching threshold: It is possible that a file could be modified in such a way that it becomes
impractical to patch it. An example would be a database that is re-indexed.

In such a case, the patching can take extremely long (it may exceed the backup window) and will eventually
create a patch that is the same size as the complete file. It would be better to abort the patching and compress
the new file instead. When the patching threshold is reached, patching will be aborted and the complete file will
be compressed and resent to the Storage Platform.

To specify the Binary Patching threshold:
1. Select the Enable Binary Patching threshold check box.

2. In the associated box, specify the abort threshold in gigabytes.

Note:

o When this threshold is reached, patching will be aborted and the complete file will be
compressed and resent to the Storage Platform.

e Patching limits should only be enabled if you have severe patching problems with large files.

Mandatory Patching area

The Mandatory Patching area enables you to specify files to be scanned for changes, regardless of whether or
not it appears that they have changed since the last backup.
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Tip: Mandatory patching is useful in situations where files are held open by an application (internally
the file has changed but the change is not reflected in the last modified date on the file system or in
the size of the file itself).

Note: VSS enables the backup of these files without impacting the running application or corrupting
the files.

To include files for mandatory patching:

1. Add the files you want to include for Mandatory Patching to your backup selection before they are added
to Mandatory Patching or they will not be backed up.

2. In Mandatory Patching, click the Add button.

3. Use the Open dialog box to select the file(s), and then click Open. The path to the file(s) will display in
the associated box.

4. Click OK to save your settings.

Tip: Select more than one file at a time by holding down the SHIFT key and selecting the files with
your keyboard or mouse.

Files selected for mandatory patching display in the Backup Selection tab with a green [ |~ my Music
icon containing the letter “M”: ® |~ My Pictures
) desktop.ini

@ Reqgisters.txt

Disk Usage

You can use the Disk Usage page in the Options and Settings dialog box to specify the working folders and
control the disk footprint.
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< Options and Settings
Bacup A
Backup Schedule Working Folders

. Global Exdlusions | Local Disk

_ Communications | Temp: C:\Program Files\BackupVault\Backup Client SE\toBackup
Connection Cache: C:\Program Files\BackupVault\Backup Client SE\cache
Connection Throttle Database: |C:\Program Files\BackupVault\Backup Client SE

Note: Performance will be degraded if the Cache and Temp folders are on different drives.

Advanced Communications
Cache
Backup Priority Note: The longer files are kept in cache, the better the chances are that patches, instead of full files,
are sent during backup.
Compression
Patching Disk Footprint
_ Stream backups directly to the Storage Platform
Advanced Performance Streaming Backup uses very little disk space and is optimised for use in environments where
I . bandwidth is not lmited, e.g. data centres.
Logging Please note, when this setting is on:
' : - resumes are not supported
- Delta Blocking is enforced
[] Enforce minimum free space on hard drive: 10 | GB

Working Folders area

e If you have limited space on the drive where the Backup Client is installed, you can move the Temp,
Cache and Database folders to another location.

o Temp — Used as temporary workspace when the files are patched, compressed and encrypted.

o Cache — Keeps a local, compressed and encrypted, copy of the selected files for a specified number
of days.

o Database — Compares the latest backup selection with the previous backup to determine the
changes.

Note:

e Performance will be degraded if the Temp and Cache folders are on different
drives.

e If you move these folders to a network share, please ensure that the Backup Client
has the correct permissions to reconnect and write to that share. Storing the folders
on a UNC path degrades backup performance.

o Days to keep files in cache - When modifications are made to a file, the Backup Client only transmits

changes to that file, as opposed to transmitting the complete file again. This is accomplished by the use
of a local cache.

By default, recently modified files are kept in the cache for 20 days, after which they will be deleted.
Once a file has been flushed from the cache, a full copy will be backed up when any modifications are
made to the file. The longer files are kept in the cache, the better the chance of only transmitting patches
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instead of full copies and thus reducing the amount of data that needs to be transmitted. If there is
limited disk space available, consider shortening the time files are kept in the cache.

@ Note: If you specify 0 days, patching is disabled. All files in the cache will be deleted, and full
copies of changed files will be transmitted to the Storage Platform during each backup.

e To delete the current cache, click the Clear button. If the cache is deleted, full copies of the selected files
will be re-sent to the Storage Platform during the next backup.

Disk Footprint

To enable Streaming Backup:

Select the Stream backups directly to the Storage Platform check box. Streaming Backup causes data to be
transferred to the Storage Platform without being written to temporary storage first. Streaming Backup has the
following benefits:

e Extremely fast
e Uses very little disk space

e Optimised for use in environments where bandwidth usage is not an issue, e.g. data centres

Streaming Backup has the following limitations:

e Supports Delta Blocking only, not Binary Patching
e Does not support resumes

e Provides target de-duplication only, not source de-duplication

Streaming Backup disables certain options:

¢ Advanced Communications > Concurrent Transfer
e All patching options aside from Mandatory Patching - Streaming Backup only supports Delta Blocking

e Advanced Performance > Backup Limit

68

Copyright © Blueraq Networks Ltd. All rights reserved



& BACKUPVAULT

To enforce a minimum amount of free space on your hard drive:

To ensure that the Backup Client does not use all available hard drive space during data dumps, patching or
compression, you can select the Enforce minimum free space... check box, and then specify the amount of
free disk space that must remain available.

Advanced Performance

You can use the Advanced Performance page in the Options and Settings dialog box to configure the settings
relating to:

e VSS and Change Journal
e Backup limit

e Memory allocation

Advanced Performance

VSS and Change Journal

Use Volume Shadow Copying (VSS) to back up locked files

Use NTFS Change Journal for supported volumes

Connection
Backup Limit

Connection Throttle

Advanced Communications Restrict the size of each backup: MB

_ [V] cydle backup process until all the selected data has been transferred

The backup process will be repeated unti all the data has been transferred to the Storage

Backup Priority Platform.
Compression
— Memory Allocation

Disk Usage Backup service: MB

Note: Changing these settings requires a Backup Service andjor Backup Client Interface restart.

Lok J[ cance J[ tep |

The Advanced Performance page in the Options and Settings dialog box consists of the following areas:
e VSS and Change Journal
e Backup Limit

e Memory Allocation

VSS and Change Journal area

Use Volume Shadow Copying (VSS) to back up locked files
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Microsoft Volume Shadow Copy Service (VSS) provides a solution by creating a snapshot of data at any given
point in time without any interruption to any applications. Using this option enables the backup of open or locked
files.

Note:

e For files under heavy use, VSS may increase disk usage during backup. The larger the files,
the greater the disk usage.

e Please use relevant plug-ins to back up databases.

Use NTFS Change Journal for supported volumes

Select this check box to enable the Backup Client to use the NTFS Change Journal to determine the file and
folder changes on the drive instead of performing a full scan on the drive before every backup.

Q Tip: This is especially useful when backing up large selections that would result in lengthy scanning
processes.

Backup Limit area

If you wish to limit the total amount of data that may be transferred during each backup, select the Restrict the
size of each backup check box, and then specify a maximum size in the box provided.

Note:

e This feature is especially useful if you have a poor Internet connection and encounter
problems with transmitting large backups.

e File changes will be sent in the same backup regardless of whether a size restriction is
specified.

Cycle backup process... — You can use this setting in conjunction with the backup size restriction to cycle
backups successively until all data included in the backup selection has been transmitted to the Storage
Platform. This setting can only be enabled if a backup size restriction has been specified.

Warning:

e It may take several backups before all your files are backed up to the SP because the
Backup Client will transfer new files only after changes to existing files have been
transferred.

e If changes to files amount to the size restriction, larger files such as databases might not be
backed up at all.

Memory Allocation area

Use the Backup service and Backup Client interface boxes to set the respective memory amounts.

the change takes effect. If you change the Backup Client interface amount, you will need to restart

@ Note: If you change the backup service amount, you will need to restart the backup service before
the interface before the change takes effect.
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Logging
You can use the Logging page in the Options and Settings dialog box to specify your logging preferences.
Modifiable logging settings include:

e Location of backup and restore logs

e Level of detail included

¢ Date inclusion/exclusion in time stamp

e Log file retention period

e Debug message inclusion/exclusion in service log

% Options and Settings @
Backup Account Logging
Backup Schedule Backup Logs
| Location: C:\Program Files\BackupVault\Backup Client SE\ogs
Communications
Level of detail: | All information v
Connection ’ ’
Connection Throttle [7] Include date in log file time stamp
lete log files ol : = Delete older logs now

Adv O —— [7] Delete log files older than (days) 30 rlogsr
PRI Service Log

Backup Priority

[ Log debug messages

Compression

Patching

Disk Usage

Advanced Performance

The Logging page in the Options and Settings dialog box consists of the following areas:
e Backup Logs

e Service Log

Backup Logs area

In this area, you can specify where to store the backup and restore logs, as well as the level of detail to be
displayed in them. You can also select the Include date in log file time stamp check box to add the date to
every line in each log file.

You can also enable a log file retention period by specifying that the Backup Client delete files older than a
particular number of days. To do this, select the Delete log files older than (days) check box, and then specify
the number of days in the box provided.
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Q Tip: To delete all logs older than the specified number of days immediately, click the Delete older
logs now button.

Service Log area

In this area, you can specify whether or not debug messages should be logged.

Advanced tools

SE includes tools that allow advanced users to modify, enhance and streamline the Backup Client.

Add network volume

The Backup Client provides the option to add network volumes and include files located in these locations to the
backup selection.

Warning: Please ensure that the backup service is started by a user with sufficient permissions to
browse and access the network shares to be included in the backup selection.

The Backup Client will only be able to back up files from a network volume after the share has been accessed
and authenticated by the server on which the Backup Client is installed.

To add a network volume:

1. On the Tools menu, click Add Network Volume.

2. In the UNC Path box, type the UNC network path, starting with "\". Alternatively, use the Browse button
to browse to the network path.

% Example: \\storageserver\documents

On the Backup Selection tab, network volumes are listed in the left-hand pane, accompanied by a network icon

Files in the network volume can now be included or excluded. (For more information on how to include and
exclude files, see Selecting data to back up in Chapter 6, “Backups”):

e If some files are included for backup, the icon will display with a green tint: ==.
¢ If the entire share is included it will change to a green icon: ==.

e Excluded network volumes are marked with red network icons: ;:g.

To remove a network volume from the Backup Client:

1. Right-click on the entry in the left-hand pane.
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2. Click Remove Network Volume.

The network volume will be removed from the left-hand pane.

Remote Management

Remote Management enables the Backup Administrator to remotely access and configure the Backup Client
using the Storage Platform Console.

To enable Remote Management:

1. On the Tools menu, click Remote Management.

2. In the Remote Management Settings dialog box that appears, select the Enable Remote
Management check box.

3. In the Connection area, ensure that the port number in the Port box is correct (9091 is specified by
default). If incorrect, modify as required.

4. |If the server has multiple IP addresses available, you can specify whether the Remote Service must bind
to all available IP addresses or to only one IP address.

5. Inthe Access area, select the access credentials to be allowed.

Note:

@ e Allow SP controlled access enables Backup Administrators with the correct access
permissions to use their Storage Platform User Access Management usernames and
passwords to connect to and administer this Backup Client. If you clear this check
box, Storage Platform administrators will not have remote access.

e Select Allow custom access and supply a username and password if you do not
wish to make use of the above-mentioned Storage Platform Access Accounts. These
custom access credentials must be specified in the Storage Platform Console for its
user to gain remote access.

6. Click OK to save the settings. Services will restart automatically to apply the settings.

Note: You can use the command-line interface (CLI) to enable SE Remote Management and to
@ send a wide range of backup and restore commands. For more information, see “Command-line
backups and restores” later in this chapter.

Multiple backup sets

When a backup is initiated, the backup selection is sent to the Storage Platform as a “backup set’; a set of
included files and folders. You can restore the entire backup set (all its files and folders structured as they were
at the time of backup), or restore individual files and/or folders within it.

The first backup selection you make in the SE Client is automatically saved as the “default backup set”. For more
information, see Selecting data to back up in Chapter 6, “Backups”. You may, however, create more than one
backup set. This enables you to back up different data selections at different times.
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Example: A full backup of all data on a server can be scheduled to run once a week (e.g. over the

% weekend, when there are no resource limitations) and another backup of only the SQL database on
that same server can be scheduled to run every day. This ensures that the SQL database is backed
up regularly, using minimal resources, and that the entire server is still backed up but at more
convenient and practical time intervals.

@ Note: A maximum of 10 backup sets are allowed (including the default backup set).

To create a new backup set:

1. On the Tools menu, point to Additional Backup Sets and then click Add. Alternatively, click
the Add button above the Backup Selection/Restore/Logs tabs.

@ Note: The Add button will only be available above the Client tabs when at least two backup
sets exist. If this is your first addition, you need to use the Tools menu.

2. In the Backup set name box, type a display name for the set, and then click OK.
3. Ensure that the new name is selected in the Backup set drop-down box.

4. Configure the schedule as desired. For detailed instructions on how to schedule backups, see
Scheduling automatic backups in Chapter 6, “Backups”.

Note: If backup set schedules overlap due to manual schedule configuration or overlapping

@ backup windows, the backups will be placed in a queue. Three seconds after the first backup
in the queue is complete, the next will run. Backup sets are queued alphanumerically. If,
however, two or more backups are scheduled for the same backup set and their backup
windows overlap, the first backup will run to completion and duplicates will be excluded from
the queue.

5. Click OK. The Options and Settings dialog box will close and the SE Backup Client will display the new
backup set name in a Backup set drop-down box above the Backup Selection tab.

Backup Client if more than one backup set is enabled. If only the default backup set exists,

@ Note: The Backup set drop-down and Add and Schedule buttons only display in the SE
these items will not display.

The Backup Selection, Restore and Logs tabs now display information relevant to the new backup set
and they can be used to configure, restore from and monitor it accordingly.

6. Select the data to be backed up in this backup set.
Included data will be backed up at the times specified in the backup set’'s backup schedule and can be restored

using the Restore tab.

To rename a backup set:

1. From the menu, open Tools, Additional Backup Sets, then click Manage.
2. Select the backup set name in the Backup set drop-down list.

3. Click the Rename backup set button .

74
Copyright © Blueraq Networks Ltd. All rights reserved



& BACKUPVAULT

4. Type the new name in the Backup set name box.

5. Click Ok.

To modify a backup set's backup schedule:

1. From the menu, open Tools, Additional Backup Sets, then click Manage.

2. Select the backup set name in the Backup set drop-down list.

3. Configure the schedule. (See Scheduling automatic backups in Chapter 6, “Backups”.)

4. Click Ok.

To delete a backup set:

1. From the menu, open Tools, Additional Backup Sets, then click Manage..

2
3. Click the Delete button.
4.

5. Click Ok.

Plug-ins and multiple backup sets

Select the backup set name in the Backup set drop-down list.

In the Confirmation dialog box that appears, click Yes.

The following plug-ins function only on the default backup set:

e SIMS
e System State

e Script

The following plug-ins function on additional backup sets if they have items included for backup:

e Exchange Single Item Recovery Plus (SIR Plus)

e MS SQL Server
e VMware

e VSS

Health Check

The Backup Client Health Check provides
information to highlight possible issues
before backup (e.g. free disk space or
file/folder access problems). It can also
provide the estimated line speed to the
Storage Platform.

The following options are available:

e Memory- Memory utilisation
statistics from the last backup as

The Health Check provides information to pre-emptively highlight possible issues, for example
free disk space problems and service access rights to files and folders. It can also provide the
estimated line speed to the Storage Platform.

Y

Memory utilisation statistics from the last backup as well as overall memory usage to date.
Data Selected
Information includes the number of files and directories selected for backup.

Disk Usage
Free space availability for all local drives.

Line Speed
Line Speed estimate to the Storage Platform by transmitting data for 10 seconds.

Service Rights
Information about the service account name and access rights to the working folders.

ast Health Check [ start | [ Close
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well as overall memory usage to date.

o Data Protected - Information includes the number of files and directories included in the backup
selection.

o Disk Usage - Free space availability for all local drives.

e Line Speed - Line Speed estimate to the Storage Platform (determined by transmitting data for 10
seconds).

¢ Service Rights - Information about the service account name and access rights to the working folders.

You can specify which checks to run by selecting or clearing the relevant check boxes in the Options area. Use
the Show Last Health Check button to see the last report. You can Print and/or Export the Health Check
reports.

To run a health check:

1. On the Tools menu, click Health Check.

2. In the Health Check dialog box that appears, specify which checks to run by selecting or clearing the
check boxes next to the options. Five checks are available (see above).

3. Click the Start button to begin the health check process. The Health Check dialog box appears,
displaying the progress of the health check until completion.

n Health Check -

| Completed

Terver TeaTTeeTT T = T

Backup Account authenticated N
Block size sent: 61,440 bytes

Bytes sent: 805.07 MB

Total time: 10s

Connection speed estimate: 80.50 MB/s

Checking service rights

Service display name: Redstor Backup Pro SE

Service short name: RedstorBackupPro-SE

Service running under account name: LocalSystem

Service installed at: C:\Program Files\Redstor Backup Pro\Backup Client
SE

Checking write access permissions for service

Cache directory: writeable

Temp directory: writeable

Database directory: writeable

Logs directory: writeable

Health check complete v

795.23 MB sent at 80.39 MB/s

4. When the message: “Health check complete” displays, click OK.

The Health Check results display in a new dialog box with options to print, export to HTML and export to CSV.

76
Copyright © Blueraq Networks Ltd. All rights reserved



& BACKUPVAULT

= | Health Check Results -

Examine the health check results below and print or export the report as needed.

Health Check Results =
Health check start time: 2016/04/07 4:29 PM
Health check end time: 2016/04/07 4:30 PM
Health check duration: 10s
Memory
I Print [ I Export to HTML | | Export to CSV | | Close |

Backup Snapshots
The Backup Snapshot feature enables you to create a backup of all items included in your backup selection and
send it to a disk drive. This snapshot data can then be moved to the Storage Platform.

You can use this feature to reduce the initial backup window if there is a large amount of data to be transferred,
typically over a slow Internet/network connection. A similar procedure enables you to restore a large amount of
data (e.g. during a disaster recovery). For more information about restore snapshots, see “Restore Snapshots

(Disaster recovery)” below.

@ Note: A snapshot backup uses Blowfish 448 encryption and the backup encryption key to encrypt
the data.

Warning:
e This procedure should only be performed with the assistance of the Backup Administrator.

e Ensure that you have an active Backup Account.

e [tis advised to perform a test backup that transfers only a small amount of data before
beginning the Backup Snapshot process.

To export a Backup Snapshot:
1. On the Tools menu, point to Snapshot, and then click Export Backup Snapshot.

2. Select The next backup must be a Snapshot backup. Ensure Verify snapshot after backup is
selected — this will confirm that the snapshot is not corrupt.

Warning:
o Verifying the snapshot causes the backup process to take significantly longer.

e Cancelling the verification cancels the backup.
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3. Specify a destination in the box provided (C:\Backups\Export\Snapshot-Backup is specified by default
on Windows Server 2008 machines.)

4. Click Backup Now. If you click OK, the next backup you initiate will be a snapshot backup.

The Snapshot data is now stored in the location specified in step 3 above and can be moved to the Storage
Platform. The Backup Administrator can then import the snapshot data to the StorageServer using the Storage
Platform Console. (For more information, please refer to the Storage Platform Console User Manual.)

Note: The Backup Account will be disabled at this point to ensure that the Snapshot data is the most
@ recent. Once the data has been successfully imported to the Storage Platform, the Account will be
enabled automatically and backups can proceed as usual.

Restore Snapshots (Disaster recovery)

The Restore Snapshot feature enables you to restore large amounts of data from a locally connected device to a
machine via the Backup Client.

Note:

e Before you can perform the steps outlined below, the snapshot data needs to be exported
from the StorageServer to a mobile storage device by a Backup Administrator. For more
information, please refer to the Storage Platform Console User Manual.

e A snapshot restore uses Blowfish 448 encryption and the backup encryption key to encrypt
the data.

To restore data from a Snapshot:

1. Connect the mobile storage device containing the snapshot data to the Client machine or to a Local Area
Network so that it has access to the Client machine.

2. On the Tools menu, point to Snapshot, and then click Import Restore Snapshot.
3. Select whether you wish to restore the data from a disk drive or recovery server.

a. If restoring from disk, select the Show Restore Snapshot(s) in Restore panel check box and
then specify the path to the data in the Snapshot location box.

Note: You need to specify the snapshot data’s parent folder, NOT the snapshot
@ folder itself. (E.g. If your snapshot data folder is called 20100506124347 and you've
pasted it to your Desktop, you need to specify C:\Users\Administrator\Desktop in
the Snapshot location box, NOT
C:\Users\Administrator\Desktop\20100506124347.)

Warning: The default snapshot location specified is: C:\Backups\Import\Snapshot-
Restore. If you wish to use this location, you need to create the folder structure on
the machine and then paste the snapshot data onto the Snapshot-Restore folder.
This folder is not created automatically. Alternatively, you can use the Browse button
to browse to the location in which you have saved the snapshot data.

b. If restoring from a recovery server, select the Do restores from recovery server check box and
then specify the server address and port number in the boxes provided. If using a proxy server,
select the Use proxy settings for recovery check box.
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@ Note: This option can only be used if the Backup Administrator has prepared a
recovery server.
4. Click OK.

The Snapshot data will display as an entry in the Restore tree, enabling you to browse a directory of its contents
and restore files and folders. For more information, see Chapter 7, “Restores”.

Command-line interface

You can use the command-line interface (CLI) to enable SE Remote Management and to send a wide range of
backup and restore commands. The CLI.bat file is included with each SE installation file.

Warning: The SE Backup Client is required and must be installed on the computer using the CLI.bat
file before the following commands can be used.

In the Command Prompt, run the cli command from the installation folder of the SE Backup Client to view the
various CLI options.
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Usage:

cli {restore|dates|status|backup|cancel|configure|update}

backup

[-allowempty]

restore

[-rd restoredateidx] [-rp restorepath | -original]
[-fd filterdate] [-fp filterpath] [-fext filterext]

[-backupset backupsetguid] [-compression on|off] [-overwrite]

[-nopermissions] [-noemptyfolders]

configure

{account|remote}

Note:

Specify -allowempty fo allow an empty backup to commence.

-rp <restorepath> must be an absolute path and the service must have full write access to the
directory.

Creating a new Backup Account via CLI (cli configure account) on an existing installation does
not delete the contents of the cache folder. The contents must be manually deleted.
Alternatively, the cache will be cleaned up after your next backup.

When restoring, the default policy is to skip existing files.
Specify -overwrite to overwrite existing files.
Specify —nopermissions fo not restore file and folder permissions.

Specify —noemptyfolders to not restore file empty folders (useful with —fext).

Examples:

To configure a Backup Account:

cli configure account

To configure Remote Management:

cli configure remote

To start a backup of the default backup set:

cli backup

To start a backup of a specific backup set:

cli backup -backupset acObe91b-08b2-461d-97618c529f46

To view the status of a task currently being performed by the backup service:
cli status

To start a restore from the last backup made, extracting files to the default restore temporary
directory:

cli restore

To view a list of available backup dates to restore from:
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cli dates
e To restore from a different date index obtained with the dates command:
cli restore -rd 2

e To restore all XLS files starting with the path C:\Documents and Settings and newer than 1
April 2002:

cli restore -fd 04/01/2002 -fext .XLS -fp "C:\Documents and Settings"
e To cancel the current running task:

cli cancel
e To check for and install an update of the Backup Client:

cli update

Profiling

Profiling enables your Backup Administrator to propagate certain client-side settings from the Storage Platform to
your Backup Client.

It can be used to enforce the following settings:
e Backup schedules
¢ Inclusions and exclusions
o Filters

o Most options and settings accessible via the Tools menu

Note: Profiled settings take priority over settings specified in the Backup Client.

@ When the Backup Client connects to the Storage Platform, it receives a list of all profiled settings.
These changes are implemented in the Backup Client. You can, however, connect to the Storage
Platform and update profiled settings manually.

To update profiled settings manually:
1. On the Tools menu, click Options.

2. On the Backup Accountpage of the Options and Settings dialog box, click the Retrieve
settings button.

The Backup Client will retrieve any profiled settings from the Storage Platform and update its options and
settings accordingly.

@ Note: Profiled settings are greyed out, and cannot be modified from within the Backup Client.

Inclusions /exclusions applied by profiling are displayed with yellow icons in the Backup Client.

File icons:

Included file
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¥ File included by filter

Excluded file

Folder icons:

Included folder

¥ Folder included by filter

© Excluded folder

Microsoft NTFS Change Journal use

The Microsoft Windows NTFS Change Journal keeps track of every change made to files and/or directories on
an NTFS volume from one point in time to another.

The Backup Client can use this Change Journal to determine the changes made to a volume since the last
backup. This enables it to skip the process of scanning all files and directories before initiating the backup.

Q Tip: This is especially useful when backing up a large selection that would result in a lengthy
scanning process.

Example: If you have thousands of files selected for backup and would like to do a successive
% backup after having changed only one file, with Use NTFS Change Journal for supported

volumes enabled, the Client will not need to scan through all the files to find the change and can

start the backup immediately after obtaining the change record from the Change Journal instead.

@ Note: This feature can only be used on NTFS-formatted drives and is therefore not supported on
MAC or Linux.

Limitations

In the following instances, the Backup Client will not use the Change Journal and will revert to performing normal
scans instead:

e If junction points are used (when a folder points to another folder on a different drive).

o If the backup selection changes. (Changing your backup selection results in NTFS not seeing a change
on your drive, so the Backup Client will have to rebuild the index. The Backup Client will only be able to
use the Change Journal from the next backup onwards.)

e |f the Change Journal logs an error.

¢ If the Change Journal wraps and overwrites entries.

Enabling/disabling NTFS Change Journal use:

1. Click the Options button on the toolbar, and then click Advanced Performance.

2. In the VSS and Change Journal area, select/clear the Use NTFS Change Journal for supported
volumes check box.
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3. Click OK.
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10. Plug-ins

BackupVault Server Edition provides solutions for numerous databases and applications in the form of plug-ins
to the Backup Client.

This user manual includes instructions for Email Notification plug-in, as it is distributed with the SE Backup
Client. Please refer to the Server Edition Plug-ins User Manual for detailed information on the other available
plug-ins and settings.

Email Notification plug-in

The Email Notification plug-in enables you to receive email notification on backup activity. You can configure the
plug-in to send emails to specified email addresses, notifying the recipients of the status of backups.

e Note: This plug-in has been included in SE installers since v4.2. If it is not installed, run the
@ Plug-in Installer and select the Email Notification plug-in.

e The Plug-in Installer will run automatically during the SE Client installation if located in the
same folder as the Client MSI.

To configure the email notification plug-in: ) Email Notification settings -

1. On the Tools menu, point to Plug-ins, and then
click Email Notification.

[] Notify me when a backup fails
2. Select the Use email notification check box to Messages Subject: Backup Failed
enable the plug—in. [ Notify me after a successful backup

3. Select the types of notifications to be emailed. The R e

. . . ["] Append the subject line with the following options and message
following options are available:

Warnings Errors encountered, Please check Log
. NOtIfy me when a baCkUp fails e.g. Backup Completed - Warnings, Errors enco ed, Please check Log
Mail settings
¢ Notify me after a successful backup To: admin@yourdomain. com

From: backup@yourdomain.com

e Append the subject line with the following

. SMTP server: smtp.yourdomain.com
optlons and message:
[ Enable STARTTLS

o Warnings [] My SMTP server requires authentication

o Errors User name:
Password:
Note: You can modify the Email
@ subjects and content by clicking in the
Messages Subject and [] Attach files
Warnings/Errors boxes, and then Attachment settings
edltlng the text. Summary, warnings and errors

Entire log file (as per Advanced Options log level setting)

Backup selection report

@ Note: The Backup Account name is automatically included in the subject, e.g. “Backup
Completed [Backup Account name]”.

84
Copyright © Blueraq Networks Ltd. All rights reserved



& BACKUPVAULT

4. In the Mail settings area, type To and From email addresses in the fields provided and supply the SMTP
server address and authentication information if necessary.

Tip: In the SMTP Server box, you can specify the SMTP Server name in isolation (e.g.
mail.smtp.com) or you can include the port number (e.g. mail.smtp.com:80).

When no port is specified, 25 will be used by default.
5. Select Enable STARTTLS to establish a secure connection to an online mail service like Gmail.

6. Click the Test button to verify that the settings are correct. A test email will be sent to the address
specified in the To box and a message will appear confirming if the email was sent successfully. Click
OK to close the message and return to the Email Notification settings dialog box.

7. Select the Attach files check box to include a log file and/or backup selection report as attachments.
8. In the Attachment settings area, select from the following options:

e Summary, warnings and errors

e Entire log file (as per Advanced Options log level setting)

e Backup selection report — Provides a summary of the backup selection

9. Click Ok to save the settings and close the Email Notification settings dialog box.

The Email Notification plug-in is now activated and configured and will start emailing reports during the next
backup.
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11. Reference

Keyboard shortcuts and hotkeys
Keys

F5

SPACEBAR x1

SPACEBAR x2

SPACEBAR x3

SHIFT+MNV

ALT+Underlined letter on menu bar
1))

¥

Page Up

Page Down

Home

End

Action

Refresh active window

Include selected file/folder

Exclude selected file/folder

Clear inclusion/exclusion

Select multiple files

Open the corresponding menu

Select previous item, or scroll up if you are in the Logs tab
Select previous item, or scroll down if you are in the Logs tab
Scroll up one page

Scroll down one page

Scroll to the beginning of the page if you are in the Logs tab

Scroll to the end of the page if you are in the Logs tab
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